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About these instructions
1 About these instructions

These instructions have been prepared with utmost care. They contain in-
formation and notes intended to ensure long-term and reliable operation.

Should you notice any discrepancies or if you have improvement requests, 
then we would be glad to receive your feedback through Customer 
Service ( p. 160).

Consider the instructions part of the product and store them in a place 
where they are readily available. 

1.1 For whom are these instructions intended?

These instructions are intended for:

• Specialists: 
This group has the appropriate technical training for performing 
maintenance or repairing malfunctions. 

With regard to minimum qualification and other requirements to be met by 
personnel, please also follow the chapter Safety ( p. 10).

1.2 Representation conventions – symbols and characters

Various information in these instructions is represented or highlighted by the 
following characters in order to facilitate easy and quick understanding:

Proper setting

Specifies proper setting.

Disturbances

Specifies the disturbances that can occur from an incorrect setting.

Cover

Specifies which covers must be disassembled in order to access the com-
ponents to be set.
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About these instructions 
Steps to be performed when operating the machine (sewing and 
equipping)

Steps to be performed for service, maintenance, and installation

Steps to be performed via the software control panel

The individual steps are numbered:

First step

Second step

The steps must always be followed in the specified order.

Lists are marked by bullet points.

Result of performing an operation

Change to the machine or on the display/control panel.

Important

Special attention must be paid to this point when performing a step.

Information

Additional information, e.g. on alternative operating options.

Order

Specifies the work to be performed before or after a setting.

References

 Reference to another section in these instructions.

Safety Important warnings for the user of the machine are specifically marked. 
Since safety is of particular importance, hazard symbols, levels of danger 
and their signal words are described separately in the chapter Safety 
( p. 10).

Location 
information

If no other clear location information is used in a figure, indications of right 
or left are always from the user's point of view.

1.

2.

…

•


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About these instructions
1.3 Other documents

The machine includes components from other manufacturers. Each man-
ufacturer has performed a hazard assessment for these purchased parts 
and confirmed their design compliance with applicable European and na-
tional regulations. The proper use of the built-in components is described 
in the corresponding manufacturer's instructions.

1.4 Liability

All information and notes in these instructions have been compiled in 
accordance with the latest technology and the applicable standards and 
regulations. 

Dürkopp Adler cannot be held liable for any damage resulting from:

• Breakage and damage during transport

• Failure to observe these instructions

• Improper use

• Unauthorized modifications to the machine

• Use of untrained personnel

• Use of unapproved parts

Transport

Dürkopp Adler cannot be held liable for breakage and transport damages. 
Inspect the delivery immediately upon receiving it. Report any damage 
to the last transport manager. This also applies if the packaging is not 
damaged. 

Leave machines, equipment and packaging material in the condition in 
which they were found when the damage was discovered. This will ensure 
any claims against the transport company.

Report all other complaints to Dürkopp Adler immediately after receiving 
the product.
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Safety
2 Safety

This chapter contains basic information for your safety. Read the instruc-
tions carefully before setting up or operating the machine. Make sure to 
follow the information included in the safety instructions. Failure to do so 
can result in serious injury and property damage.

2.1 Basic safety instructions

The machine may only be used as described in these instructions.

These instructions must be available at the machine's location at all times.

Work on live components and equipment is prohibited. Exceptions are de-
fined in the DIN VDE 0105.

For the following work, switch off the machine at the main switch or dis-
connect the power plug:

• Replacing the needle or other sewing tools

• Leaving the workstation

• Performing maintenance work and repairs

• Threading

Missing or faulty parts could impair safety and damage the machine. 
Only use original parts from the manufacturer.

Transport Use a lifting carriage or forklift to transport the machine. Raise the ma-
chine max. 20 mm and secure it to prevent it from slipping off.

Setup The connecting cable must have a power plug approved in the relevant 
country. The power plug may only be assembled to the power cable by 
qualified specialists.

Obligations 
of the operator

Follow the country-specific safety and accident prevention regulations and 
the legal regulations concerning industrial safety and the protection of the 
environment.

All the warnings and safety signs on the machine must always be in legible 
condition. Do not remove!  
Missing or damaged warnings and safety signs must be replaced 
immediately. 

Requirements 
to be met by 

the personnel

Only qualified specialists may:

• set up the machine

• perform maintenance work and repairs

• perform work on electrical equipment

Only authorized persons may work on the machine and must first have un-
derstood these instructions.
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Operation Check the machine during operating for any externally visible damage. 
Stop working if you notice any changes to the machine. Report any chang-
es to your supervisor. Do not use a damaged machine any further.

Safety 
equipment

Safety equipment should not be removed or deactivated. If it is essential 
to remove or deactivate safety equipment for a repair operation, it must be 
assembled and put back into operation immediately afterward.

2.2 Signal words and symbols used in warnings

Warnings in the text are distinguished by color bars. The color scheme is 
based on the severity of the danger. Signal words indicate the severity of 
the danger.

Signal words Signal words and the hazard they describe:

Symbols The following symbols indicate the type of danger to personnel:

Signal word Meaning

DANGER (with hazard symbol)
If ignored, fatal or serious injury will result

WARNING (with hazard symbol)
If ignored, fatal or serious injury can result

CAUTION (with hazard symbol)
If ignored, moderate or minor injury can result

CAUTION (with hazard symbol)
If ignored, environmental damage can result

NOTICE (without hazard symbol)
If ignored, property damage can result

Symbol Type of danger

General

Electric shock
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Safety
Examples Examples of the layout of warnings in the text:

 This is what a warning looks like for a hazard that will result in serious 
injury or even death if ignored.

 This is what a warning looks like for a hazard that could result in seri-
ous or even fatal injury if ignored.

 This is what a warning looks like for a hazard that could result in 
moderate or minor injury if the warning is ignored.

Puncture

Crushing

Environmental damage

Symbol Type of danger

DANGER

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.

WARNING

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.

CAUTION

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.
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Safety 
 This is what a warning looks like for a hazard that could result in envi-
ronmental damage if ignored.

 This is what a warning looks like for a hazard that could result in 
property damage if ignored.

CAUTION

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.

NOTICE

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.
13 Service Instructions 911-211 - 02.0 - 10/2016



Working basis
3 Working basis

3.1 Order of the settings

The settings for the machine are interdependent.

Always comply with the order of individual setting steps as specified.

It is absolutely essential that you follow all notices regarding prerequisites 

and subsequent settings that are marked with  in the margin.

3.2 Cable routing

To lay the cables:

1. Lay any excess cabling neatly in proper cable snakes.

2. Bind together the cable loops with cable ties. 
Tie loops wherever possible to fixed parts.

Important

The cables must be secured firmly!

3. Cut off any overlapping cable ties.

NOTICE

Property damage may occur!

Machine damage from incorrect order.

It is essential to follow the working order specified in these 
instructions.

NOTICE

Machine damage and malfunctions can be caused by laying the 
cables incorrectly!

Excess cables can impair the functioning of moving machine parts. 
This impairs the sewing function and can result in damage.

Lay excess cable as described above.
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3.3 Removing and opening covers

In many types of setting work, you will have to remove the machine covers 
in order to access the components.

This chapter describes how to remove and then refit the individual covers. 
The text for each type of setting work then specifies only the cover that 
needs to be removed at that particular time.

3.3.1 Access to the underside of the machine

Cover

To access the components on the underside of the machine, swivel up the 
machine head.

Fig. 1: Access to the underside of the machine

Swiveling up the machine head

To swivel up the machine head:

1. Release the locking lever (1) under the tabletop.

2. Lift the machine head in the head cover area (2) and swivel up carefully.

 The latch (4) latches into place.

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch the machine off before removing or re-placing 
covers.

(1) - Locking lever
(2) - Head cover

(3) - Drive carriage
(4) - Latch

① ② ③ ④
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Swiveling down the machine head

To swivel down the machine head:

1. Hold the machine head in the head cover area (2).

2. Release the latch (4).

3. Swivel down the machine head.

4. Latch the locking lever (1) under the tabletop.

3.3.2 Removing and assembling the motor cover

Fig. 2: Removing and assembling the motor cover

Removing the motor cover

To remove the motor cover:

1. Loosen both screws (1).

2. Remove the motor cover (2).

Placing the motor cover

To place the motor cover:

1. Place the motor cover (2).

2. Tighten both screws (1).

(1) - Screws (2) - Motor cover

①
②
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3.3.3 Removing and placing the arm cover

Fig. 3: Removing and placing the arm cover

Removing the arm cover

To remove the arm cover:

1. Unscrew the motor cover (1).

2. Loosen screws (2) and countersunk screw (3).

3. Remove the arm cover (4).

Placing the arm cover

To place the arm cover:

1. Place the arm cover (4).

2. Tighten the countersunk screw (3).

3. Tighten the screws (2).

4. Press down the hand crank (5) and check for ease of movement; adjust 
the arm cover position if necessary.

 The hand crank (5) must disengage.

5. Place the motor cover (1).

(1) - Motor cover
(2) - Screws
(3) - Countersunk screw

(4) - Arm cover
(5) - Hand crank

②

④①

③

⑤
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Working basis
3.3.4 Removing and placing the head cover

Fig. 4: Removing and placing the head cover

Removing the head cover

To remove the head cover:

1. Loosen the screws (1).

2. Remove the head cover (2).

Placing the head cover

To place the head cover:

1. Place the head cover (2).

2. Tighten the screws (1).

(1) - Screws (2) - Head cover

①

②

Service Instructions 911-211 - 02.0 - 10/2016 18



Working basis 
3.3.5 Removing and placing the rear cover

Fig. 5: Removing and placing the rear cover

Removing the rear cover

To remove the rear cover:

1. Loosen all 3 screws (1).

2. Take off the rear cover (2) by moving it back.

Placing the rear cover

To place the rear cover:

1. Place the rear cover (2).

2. Tighten all 3 screws (1).

(1) - (2) - 

①
②
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3.3.6 Removing and placing the toothed belt cover

Fig. 6: Removing and placing the toothed belt cover

Removing the toothed belt cover

To remove the toothed belt cover:

1. Loosen all 4 screws (1).

2. Remove toothed belt cover (2). 

Placing the toothed belt cover

To place the toothed belt cover:

1. Place the toothed belt cover (2).

2. Tighten all 4 screws (1).

(1) - Screws (2) - Toothed belt cover

①

②
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Working basis 
3.3.7 Opening and closing the bobbin flap

Fig. 7: Opening and closing the bobbin flap

Opening the bobbin flap

To open the bobbin flap:

1. Switch on the machine and reference it.

2. Remove the sewing material holder.

3. Press the Threading mode button.

 The bobbin flap (1) pivots to the side.

Closing the bobbin flap

To close the bobbin flap:

1. Release the Threading mode button.

2. Place the sewing material holder.

(1) - Bobbin flap

①
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Working basis
3.3.8 Removing and placing the sliding plate

Fig. 8: Removing and placing the sliding plate

Removing the sliding plate

To remove the sliding plate:

1. Reach through the hole (2) from below and lift the sliding plate (1). 

2. Remove the sliding plate (1).

Placing the sliding plate

To place the sliding plate:

1. Place the sliding plate (1).

(1) - Sliding plate (2) - Hole

① ②
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3.3.9 Removing and installing the burner cover (optional)

Fig. 9: Removing and installing the burner cover

Removing the burner cover

To remove the burner cover:

1. Loosen both screws (2).

2. Remove the burner cover (1). 

Placing the burner cover

To place the burner cover:

1. Place the burner cover (2).

2. Tighten both screws (1).

3.4 Flats on shafts

Fig. 10: Flats on shafts

Some shafts have flats at those points where the components are clamped 
on to the shaft. This stabilizes the connection and makes setting easier.

(1) - Burner cover (2) - Screws

①

②

(1) - Flat (2) - Shaft

①

②
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Important

Always ensure that the screws are completely flush with the surface.

3.5 Aligning the machine head

Proper setting

The upper side of the base plate (1) is in level with the cutout in the table-
top (2). Height X of the transport system is identical on the left and the right 
both at the rear and the front position of the carriage. 

Check the height using the flat material (3).

Fig. 11: Aligning machine head (1)

Fig. 12: Aligning machine head (2)

Order

1. Remove the sliding plate ( p. 22).

2. Check the position of the machine head using the flat material (3).

(1) - Base plate
(2) - Tabletop

(3) - Flat material

③①

②

X X
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Working basis 
3. Swivel up the machine head ( p. 15).

4. Set the height.

5. Check the position of the machine head again.

• Front

• Carriage at rear position

• Carriage at front position

Fig. 13: Aligning machine head (3), carriage at rear position

Fig. 14: Aligning machine head (4), carriage at front position

X

X
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Working basis
Fig. 15: Aligning machine head (5)

Setting steps

1. Loosen the nuts (5).

2. Swivel down the machine head and lock it in place.

3. Use screws (4) to correct the height of the machine head at the front:

• higher = turn counterclockwise

• lower = turn clockwise

4. To adjust the locking mechanism, loosen the screws (6).

5. Move the clamp (7) up or down.

• To slacken the locking mechanism: Slide the clamp up

• To tighten the locking mechanism: Slide the clamp down

6. To test the setting, lock the machine head and check the play.

Proper setting

The locking mechanism is set correctly if the machine head can be locked 
in place with ease while not showing any play at the front bearing when 
moved up and down.

(4) - Screws
(5) - Nuts

(6) - Screws
(7) - Block

④

⑤

④

⑤

⑥

⑦
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Fig. 16: Aligning machine head (6)

7. Loosen the screws on the left (not shown) and on the right (8).

8. Use the threaded pins on the left (not shown) and on the right (9) to 
adjust the height of the machine head at the rear:

• higher = turn clockwise

• lower = turn counterclockwise

9. Test the height of the base plate using flat material (3) and adjust as 
necessary.

10. Check heights X and adjust as necessary.

11. Check locking mechanism and adjust as necessary.

(8) - Screw on the right (9) - Threaded pin on the right

⑨

⑧
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3.6 Locking the machine in place

For some settings, the machine must be locked in place. To do this, the 
locking peg from the accessory pack is inserted into a slot on the arm shaft 
crank, blocking the arm shaft.

Fig. 17: Lock the machine in place (1)

There are 2 securing positions:

• Position 1: Loop stroke position

• 5 mm end in the large slot

• Setting the loop stroke and needle bar height

• Position 2: Needle at top dead center

• 3 mm end in the small slot

• Checking the top dead center of the needle bar

Fig. 18: Lock the machine in place (2)

Locking the machine in place

1. Insert the locking peg (6) with the appropriate end into the slot (5) of 
the arm shaft crank (4).

(1) - Locking peg
(2) - Large arresting groove

(3) - Small arresting groove
(4) - Arm shaft crank

(1) - Locking peg (2) - Large arresting groove

①

②

③

④

①②
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Removing the lock

1. Pull the locking peg (6) out of the slot (5).

3.7 Putting the machine into position

For some settings, the machine must be put into a certain position, using 
the hand crank on the arm cover. The machine has no handwheel.

Fig. 19: Putting the machine into position

To set the machine into position:

Press down and turn the hand crank (1) until the machine is in the setting 
position.

(1) - Hand crank

①
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4 Machine head

4.1 Positioning the arm shaft crank

Proper setting

The 3 threaded pins (2) on the arm shaft crank (1) are seated completely 
on the flat.

Cover

• Arm cover ( p. 16)

Fig. 20: Positioning the arm shaft crank

To set the arm shaft crank:

1. Loosen all threaded pins (2) on the arm shaft crank (1).

2. Turn the arm shaft crank (1) such that the threaded pins (2) are seated 
completely on the flat of the arm shaft.

3. Push the arm shaft crank (1) to the right as far as it will go.

4. Tighten all the threaded pins (2) on the arm shaft crank (1).

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch the machine off before you check and set 
the position of the arm shaft crank.

(1) - Arm shaft crank (2) - Threaded pins

②

①
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4.2 Positioning the toothed belt wheels

The two toothed belt wheels must be positioned relative to each other 
such that the toothed belt can run correctly.

Order

• Always check the position of the other toothed belt wheel after making a 
change on either of the toothed belt wheels.

4.2.1 Setting the upper toothed belt wheel

Proper setting

The 2 threaded pins for the upper toothed belt wheel are seated flush on 
the flat.

Cover

• Arm cover ( p. 16)

Fig. 21: Setting the upper toothed belt wheel

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch the machine off before you check and set 
the upper toothed belt wheel.

(1) - Threaded pins
(2) - Flat of arm shaft

(3) - Upper toothed belt wheel
(4) - Toothed belt

①

② ③

④
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To set the upper toothed belt wheel:

1. Using the screwdriver, push the toothed belt (4) sufficiently far to the 
side so that the 2 threaded pins (1) can be reached.

2. Loosen the threaded pins (1).

3. Turn the upper toothed belt wheel (3) such that the threaded pins (1) 
are seated flush on the flat (2) of the arm shaft.

4. Tighten the threaded pins (1).

5. Use the screwdriver to push the toothed belt (4) back again.

4.2.2 Setting the lower toothed belt wheel

Proper setting

Both threaded pins for the lower toothed belt wheel are seated flush on the 
flat of the lower shaft.

The toothed belt runs correctly without running against the edge of the off-
set gear wheel or slipping off.

Cover

• Swivel up the machine head ( p. 15)

• Toothed belt cover ( p. 20)

Fig. 22: Setting the lower toothed belt wheel

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch the machine off before you check and set 
the lower toothed belt wheel.

(1) - Toothed belt
(2) - Edge

(3) - Lower toothed belt wheel
(4) - Threaded pins

① ② ③ ④
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To set the lower toothed belt wheel:

1. Loosen both threaded pins (4).

2. Turn the lower toothed belt wheel (3) such that the threaded pins (4) 
are seated completely on the flat of the lower shaft.

3. Move the lower toothed belt wheel (3) sufficiently far to the side so that 
the toothed belt (1) makes contact with the edge (2) without being 
pushed away.

4. Screw both threaded pins (4) firmly in place.

4.3 Aligning the needle bar linkage

Order

First, check the following setting:

• A straight and undamaged needle has to be inserted ( Operating 
Instructions)

Proper setting

1. Turn the needle bar to the bottom.

 The needle must enter the needle hole precisely in the center.

Cover

• Head cover ( p. 18)

Fig. 23: Aligning the needle bar linkage

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch off the machine before aligning the needle 
bar linkage sideways.

(1) - Threaded pins
(2) - Throat plate

(3) - Needle bar linkage

①

②

③
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To align the needle bar linkage:

1. Loosen both threaded pins (1).

2. Set the needle bar linkage (3) so that the needle enters the needle 
hole (2) precisely in the center.

3. Tighten the threaded pins (1).

4.4 Position of the hook and needle

4.4.1 Setting the loop stroke position

Information

The loop stroke is the path length from the bottom dead center of the nee-
dle bar up to the height where the hook tip picks up the loop of thread.

Fig. 24: Setting the loop stroke position (1)

The loop stroke is precisely 2.4 mm.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the loop stroke position.

(1) - Needle
(2) - Groove

(3) - Hook tip

① ③

②
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Order

First, check the following settings:

• Needle bar linkage ( p. 33)

• A straight and undamaged needle has to be inserted ( Operating 
Instructions)

Proper setting

Machine is locked in place at position 1 ( p. 28).

 The hook tip (3) is precisely at the center (1) of the needle.

Disturbance caused by an incorrect setting

• Missing stitches

Cover

• Swivel up the machine head ( p. 15)

Fig. 25: Setting the loop stroke position (2)

To set the loop stroke position:

1. Lock the machine in place at position 1 ( p. 28).

2. Loosen all 4 threaded pins (5) for the clamping ring (4) on the hook 
shaft.

3. Rotate the hook such that the hook tip (7) is precisely at the center of 
the needle (6).

4. Tighten the threaded pins (5) for the clamping ring (4).

5. Remove the lock ( p. 29).

Order

Then check the following settings:

• Position of the needle guard ( p. 40)

• Timing of cutting by the thread cutter ( p. 79)

(1) - Clamping ring
(2) - Threaded pins

(3) - Groove
(4) - Hook tip

3

4

1

2
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4.4.2 Setting the needle bar height

Order

First, check the following settings:

• Loop stroke position ( p. 34)

• A straight and undamaged needle has to be inserted ( Operating 
Instructions)

Proper setting

Machine is locked in place at position 1 ( p. 28).

 The hook tip is level with the lower third of the groove on the needle.

Disturbances caused by an incorrect needle bar height

• Damage to the hook tip

• Jamming of the needle thread

• Missing stitches

• Thread breaking

• Needle breakage

Cover

• Head cover ( p. 18)

• Bobbin flap ( p. 21)

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the needle bar height.
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Fig. 26: Setting the needle bar height

To set the needle bar height:

1. Lock the machine in place at position 1 ( p. 28).

2. Loosen the screws (1).

3. Remove the throat plate (6).

4. Loosen the screw (3) of the needle bar (2).

5. Move the height of the needle bar (2) so that the hook tip (4) is in the 
middle of the lower third of the groove on the needle (5).

Important

When doing this, take care not to twist the needle. The groove (5) must 
face toward the hook.

6. Tighten the screw (3) for the needle bar (2).

7. Place the throat plate (6).

8. Tighten the screws (1).

9. Remove the lock ( p. 29).

Order

Then check the following setting:

• Position of the needle guard ( p. 40)

(1) - Screws
(2) - Needle bar
(3) - Screw

(4) - Hook tip
(5) - Groove
(6) - Throat plate

④

⑤

⑥

①

②

③
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4.4.3 Setting the hook side clearance

Order

First, check the following settings:

• A straight and undamaged needle has been inserted ( Operating 
Instructions)

• Needle bar linkage ( p. 33)

• Loop stroke position ( p. 34)

Proper setting

Machine locked in place at position 1 ( p. 28).

 Maximum 0.1 mm distance between the hook tip and the groove for 
the needle.

Cover

• Swivel up the machine head ( p. 15)

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch off the machine before you check and set 
the hook side clearance.

NOTICE

Property damage may occur!

There is a risk of machine damage, needle breakage or damage to 
the thread if the distance between needle groove and hook tip is 
incorrect.

Check and, if necessary, readjust the distance to the hook tip after 
inserting a new needle with a different size.
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Fig. 27: Setting the hook side clearance

To set the hook side clearance:

1. Lock the machine in place at position 1 ( p. 28).

2. Loosen the screws (2) for the hook support (3).

3. Loosen the threaded pins for the clamping ring (1).

4. Move the hook support (3) sideways such that the distance between 
the hook tip (5) and the groove for the needle (4) is 0.1 mm at most, 
without the hook tip (5) touching the needle.

5. Tighten the screws (2) for the hook support (3).

6. Tighten the threaded pins for the clamping ring (1).

7. Check the loop stroke position ( p. 34).

8. Remove the lock ( p. 29).

Order

Then check the following setting:

• Position of the needle guard ( p. 40)

(1) - Clamping ring
(2) - Screws
(3) - Hook support

(4) - Groove
(5) - Hook tip

③

② ④

⑤

①

②
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4.4.4 Setting the needle guard

The needle guard prevents contact between needle and hook tip.

Order

First, check the following settings:

• Loop stroke position ( p. 34)

• Hook side clearance ( p. 38)

• Needle bar height ( p. 36)

• A straight and undamaged needle has to be inserted ( Operating 
Instructions)

Proper setting

Machine locked in place at position 1 ( p. 28).

 The needle guard pushes the needle away just enough so that it is 
not touched by the hook tip.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the needle guard.

NOTICE

Property damage may occur!

There is a risk of machine damage, needle breakage or damage to 
the thread if the distance between needle groove and hook tip is 
incorrect.

Check and, if necessary, readjust the distance to the hook tip after 
inserting a new needle with a different size.
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Fig. 28: Setting the needle guard

To set the needle guard:

1. Press and turn the hand crank and check how far the needle guard (1) 
pushes the needle (3) away.

2. Turn the screw (2) such that the needle guard (1) just pushes the 
needle (3) far away enough so that it is not touched by the hook tip:

• for pushing away more: Turn counterclockwise

• for pushing away less: Turn clockwise

4.4.5 Setting the needle guide 

Order

First, check the following setting:

• A straight and undamaged needle has to be inserted ( Operating 
Instructions)

Proper setting

1. Machine locked in place at position 1 ( p. 28).

 The needle guard pushes the needle just enough away so that it can-
not be touched by the hook tip.

(1) - Needle guard
(2) - Screw

(3) - Needle

③

①

②

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the needle guide.
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Disturbances caused by an incorrect setting of the needle guide

• Damage to the needle

• Missing stitches

Fig. 29: Setting the needle guide

To set the needle guide:

1. Loosen the screws (1).

2. Remove the throat plate (2).

3. Rotate the machine to position 1 ( p. 28).

4. Loosen the screw (4).

5. Move the needle guide (3) as close as possible against the needle.

6. Tighten the screw (4).

7. Check this distance using a piece of paper (5).

(1) - Screws
(2) - Throat plate
(3) - Needle guide

(4) - Screw
(5) - Paper

⑤
①

② ③ ④
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4.5 Setting the bobbin case lifter

Fig. 30: Setting the bobbin case lifter

The hook pulls the needle thread through between the nose of the bobbin 
case (3) and the middle section holder (4).

The bobbin case lifter (2) now pushes the bobbin case (1) away so that a 
gap appears for the thread.

If the hook tip is located below the bobbin case lifter, the bobbin case lifter 
must open so that the thread can also slide past in that position.

So that the thread can slip through without a problem, the width of the lift-
ing gap and the timing of opening have to be set.

Disturbances caused by an incorrect setting:

• Thread breaking

• Formation of loops on the bottom side of the seam

• Loud machine noise

(1) - Bobbin case
(2) - Bobbin case lifter

(3) - Nose of the bobbin case
(4) - Middle section holder

③

④
①

②
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4.5.1 Setting the lifting gap (standard hook bearing)

Order

Always check the width of the lifting gap after making changes to the nee-
dle thread size. The correct width of the lifting gap depends on the thick-
ness of the needle thread.

Proper setting

The needle thread slides through unobstructed between the nose of the 
bobbin case and the middle section holder.

Cover

• Swivel up the machine head ( p. 15)

Fig. 31: Setting the lifting gap (standard hook bearing)

To set the lifting gap:

1. Loosen the screw (2).

2. Push the cover (3) downwards.

3. Loosen the threaded pin (1).

4. Set the bobbin case lifter (4) such that the gap between the nose of 
the bobbin case and the middle section holder is just big enough for 
the needle thread to slip through without a problem.

5. Tighten the threaded pin (1).

6. Push the cover (3) upwards.

7. Tighten the screw (2).

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch off the machine before setting the width of 
the lifting gap.

(1) - Threaded pin
(2) - Screw

(3) - Cover
(4) - Bobbin case lifter

④

①

②

③
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4.5.2 Setting the lifting gap (special hook bearing for safety belts)

Fig. 32: Setting the lifting gap (special hook bearing for safety belts) (1)

Proper setting

The needle thread slides through the passage (2) unobstructed between 
bobbin case lifter and bobbin case. 
At the moment when the bobbin case lifter is at the point (1), there must 
be still be a gap between the nose of the bobbin case and the middle sec-
tion holder.

Information

The lifting gap on the special hook bearing used for belts is markedly wider 
than the gap on the standard hook bearing. 
If the hook thread under the seam is too loose when using short stitch 
lengths, you need to widen the passage between bobbin case lifter and 
bobbin case.

Cover

• Swivel up the machine head ( p. 15)

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch off the machine before setting the width of 
the lifting gap.

(1) - Point (2) - Passage

①

②
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Fig. 33: Setting the lifting gap (2)

To set the lifting gap:

1. Loosen the screw (4).

2. Push the cover (5) downwards.

3. Loosen the threaded pin (3).

4. Set the bobbin case lifter (6) such that the needle thread can pass 
through the passage (2) unobstructed  between bobbin case lifter (6) 
and bobbin case. 
At the moment when the bobbin case lifter is at the point (1), there 
must be still be a gap between the nose of the bobbin case and the 
middle section holder.

5. Tighten the threaded pin (3).

6. Push the cover (5) upwards.

7. Tighten the screw (4).

(2) - Passage
(3) - Threaded pin
(4) - Screw

(5) - Cover
(6) - Bobbin case lifter

⑥

③

④

⑤ ②
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4.5.3 Setting the timing for opening 

Proper setting

The bobbin case lifter starts to open exactly at the point when the hook tip 
is located below the bobbin case lifter after the loop is taken up.

Cover

• Swivel up the machine head ( p. 15)

Fig. 34: Setting the timing for opening

To set the timing for opening:

1. Remove the plug (1).

2. Press and turn the hand crank until the tip of the needle is level with 
the throat plate. The threaded pin (2) must be accessible from the 
underside of the hook support.

3. Slacken the threaded pin (2) and use a hex key to turn the socket-head 
screw so that the hex key stands exactly vertical.

4. Tighten the threaded pin (2).

5. Insert the plug (1) into the opening.

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch off the machine before you check and set 
the timing for opening.

(1) - Plug (2) - Threaded pin

① ②
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4.6 Sewing foot lift

4.6.1 Setting the stroke position drive

Fig. 35: Setting the stroke position drive

Proper setting

The toothed rack must be 16.5 ± 0.5 mm distant from the top edge (1) of 
the stroke position housing. The threaded pins must be visible in the long 
hole and must be horizontal.

Cover

• Motor cover ( p. 16)

To set the stroke position drive:

1. Loosen the threaded pins (4).

2. Remove the gear wheel (3).

3. Move the toothed rack (2) to 16.5 mm below the upper stop.

4. Insert the gear wheel (3) so that the threaded pins (4) are horizontal.

5. Tighten the threaded pins (4).

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the stroke position drive.

(1) - Top edge of the stroke position housing
(2) - Toothed rack

(3) - Gear wheel
(4) - Threaded pins

16,5±0,5 mm

③ ④

①

②
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4.6.2 Setting the light barrier

Proper setting

The light barrier with its mounting plate must be installed so that the 
toothed rack triggers it before reaching the upper stop.

1. Use the Multitest program to test the setting.

 The distance between the bottom edge of the mounting plate and the 
stroke position housing should be approx. 3.5 mm.

Fig. 36: Setting the light barrier

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Check and set the light barrier with very great care.

(1) - Mounting plate
(2) - Light barrier

(3) - Screw
(4) - Lever

3,5 mm

③

④①

②
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Cover

• Head cover ( p. 18)

• Motor cover ( p. 16)

To set the light barrier:

1. Loosen the screw (3).

2. Adjust the mounting plate (2) accordingly.

3. Tighten the screw (3).

4. Switch off and on the machine again.

5. Tap on Service.

6. Input the password (25483).

7. Tap on Multitest > Eingänge/Ausgänge testen 
(Test inputs/outputs).

8. Push the lever (4) up and monitor the display.

 It will show either +103 or -103.

9. Check that the toothed rack still has about 0.5 mm clearance from the 
stop.

10. If necessary, set the light barrier again using the mounting plate.

4.6.3 Setting the left stop screw

Proper setting

The left stop screw (3) of the lifting gear must be set so that the lever (1) 
performs no stroke when it is lying against the stop block (4). The levers 
of the lifting gear (5) overlap.

1. Switch off and on the machine again.

2. Reference the machine.

3. Tap on Extras > Service > Multitest > Hublage einstellen 
(Set stroke position).

4. Tap on Hüpfer/Drücker (Walking foot/presser foot) until 
the presser foot is selected.

5. Press and turn the hand crank and check that no stroke is performed.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the stop screw.
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Fig. 37: Setting the left stop screw

To set the left stop screw:

1. Loosen the nut (2).

2. Turn the stop screw (3) accordingly.

3. Tighten the nut (4).

(1) - Lever
(2) - Nut
(3) - Stop screw

(4) - Stop block
(5) - Lifting gear lever

①

② ③ ④ ⑤
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4.6.4 Setting the sewing foot stroke relative to the needle bar stroke

Fig. 38: Setting the sewing foot stroke relative to the needle bar stroke

Proper setting

The lifting gear (2) must be switched on so that it performs a stroke. 
The stop block (6) must then lie against the right hand stop screw (5).

WARNING

Risk of injury from moving parts!

Crushing possible.

Always use the greatest care when testing and 
setting the sewing foot stroke relative to the needle 
bar stroke.

(1) - Lever
(2) - Lifting gear
(3) - Eccentric

(4) - Sewing foot stroke
(5) - Stop screw
(6) - Stop block

② ③ ④

⑤

① ⑥
Service Instructions 911-211 - 02.0 - 10/2016 52



Machine head 
The eccentric (3) for the sewing foot stroke must be set so that

• when the needle bar is at bottom dead center - the presser foot is 
lowered

• after the loop stroke – the sewing foot stroke starts.

To set the sewing foot stroke relative to the needle bar stroke:

1. Switch off and on the machine again.

2. Reference the machine.

3. Tap on Extras > Service > Multitest > Hublage einstellen 
(Set stroke position).

4. Tap on Hüpfer/Drücker (Walking foot/presser foot) until 
the walking foot is selected.

5. Switch on the sewing foot stroke in the control.

6. Turn the machine head to the loop stroke position.

 The lever (1) must make a movement.

7. Loosen both threaded pins on the eccentric (3).

8. Rotate the eccentric (3) on the arm shaft.

9. Tighten both threaded pins on the eccentric (3).

10. Press and turn the hand crank and check that the lever (1) makes a 
movement.

4.6.5 Setting the sewing foot height

The sewing foot height can be set electronically from 1 mm to a maximum 
of 10 mm.

Proper setting

If a height of 1 mm is set in the control, the sewing foot must be 1 mm 
above the throat plate.

To set the height of the sewing foot:

1. Assemble the walking foot.

2. Tap on Extras > Service > Multitest > Hublage einstellen 
(Set stroke position).

3. Tap on Hüpfer/Drücker (Walking foot/presser foot) until 
the walking foot is selected.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Check and set the sewing foot height only with very 
great care.
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4. Tap on Nähfußhub (Sewing foot stroke).

5. Enter a sewing foot height of 1.0 mm.

6. Move to position.

7. Turn the sewing foot to bottom dead center.

 The distance between the throat plate and sewing foot must be 1 mm.

Fig. 39: Setting the sewing foot height

8. Loosen the screw (3).

9. Turn the pivot shaft so that the distance between throat plate and sew-
ing foot is 1 mm.

10. Tighten the screw (3).

11. Turn the sewing foot to top dead center.

 The distance between the throat plate and sewing foot must be 5 mm.

12. Loosen the nut (2).

13. Adjust the screw (1) so that the distance between the throat plate and 
sewing foot is 5 mm (corresponding to a 4 mm sewing foot stroke).

Information

The distance between minimum and maximum positions may have to be 
determined. If one of these settings is changed the other setting must be 
checked again.

(1) - Screw
(2) - Nut

(3) - Screw

③① ②
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4.6.6 Setting the reference light barrier sewing axis

Proper setting

To reference the needle bar, position the machine at top dead center.

1. Switch off and on the machine again.

2. Reference the machine and check that the needle bar is at top dead 
center.

Fig. 40: Setting the reference light barrier

Cover

• Arm cover ( p. 17)

To set the reference light barrier:

1. Switch off and on the machine again.

2. Tap on Multitest.

3. Input the password (25483).

4. Tap on Multitest > Eingänge/Ausgänge testen 
(Test inputs/outputs).

5. Turn the needle bar to top dead center and insert the 3 mm end of the 
locking peg to peg the arm shaft crank to position 2.

6. Loosen the threaded pin (1).

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Check and set the reference light barrier only with 
very great care.

(1) - Threaded pin
(2) - Take-up lever disk

(3) - Locking peg

① ② ③
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7. Rotate the take-up lever disk (2) on the arm shaft accordingly.

 The switch S100 then switches.

8. Tighten the threaded pin (1).

9. Remove the locking peg (3).

10. Switch off and on the machine again.

11. Check that the needle bar is at top dead center.

4.7 Setting the needle thread tension

4.7.1 Setting the needle thread regulator

The needle thread regulator determines the tension applied to guide the 
needle thread around the hook. The required tension depends on the 
thickness of the sewing material, the thread strength, and the stitch length.

Proper setting

The loop of the needle thread slides at low tension over the thickest point 
of the hook, without forming loops or snagging.

Fig. 41: Setting the needle thread regulator

To set the needle thread regulator:

1. Press and turn the hand crank and monitor the progress of the needle 
thread around the hook.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the needle thread regulator.

(1) - Screw (2) - Needle thread regulator

+

1 2 3 4

①

②
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2. Loosen the screw (2).

3. Move the needle thread regulator:

• more thread = slide to the left

• less thread = slide to the right

4. Tighten the screw (2).

4.7.2 Setting the thread tensioning spring 

The thread tensioning spring holds the needle thread under tension from 
the top dead center of the thread lever up to the point when the needle eye 
plunges into the sewing material.

Proper setting

Initial position: The thread tensioning spring does not contact the stop 
until the needle eye has plunged into the sewing material.

Important

The setting for the thread tensioning spring must be varied according to 
the sewing material and the required sewing result.

Fig. 42: Setting the thread tensioning spring

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the thread tensioning spring.

(1) - Stop collar
(2) - Spring

(3) - Tension disk
(4) - Screw

①

②

④

③
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To set the thread tensioning spring:

1. Loosen the screw (4).

2. Setting the spring travel: Turn the stop collar (1):

• longer spring travel: Turn counterclockwise

• shorter spring travel: Turn clockwise

3. Setting the spring tension: Turn the tension disk (3):

• greater spring tension: Turn counterclockwise

• less spring tension: Turn clockwise

Important

Do not twist the stop collar in doing so.

4. Tighten the screw (4).

4.7.3 Setting the thread tension plate

Fig. 43: Setting the thread tension plate

To set the thread tension plate:

1. Remove the thread from the thread tensioner.

2. Tap on Extras > Service > Multitest.

3. Input the password (25483).

4. Tap on Fadenspannung (thread tensioner) > Kalibrierung 
(Calibration 3).

5. Loosen screw (1) and nut (2).

6. Loosen the disk (3).

7. Turn the disk (3) clockwise, feeling for the stop (until the tension disks 
lie flush on each other).

8. Use a (lead) pencil to mark 12 o'clock on the disk (3) and turn it approx. 
15-30° clockwise.

(1) - Screw
(2) - Nut

(3) - Disk
(4) - Tension disk

①

②

③

④
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9. Tap on ESC or OK.

10. Tap on Kalibrierung 1 (Calibration 1).

11. Turn back the nut (2) until reaching the screw head of the screw (1).

12. Screw in the screw (1) until the nut (2) is positioned approx. 2 mm in 
front of the disk (3).

13. Loosen the screw (1) until the tension disks tighten.

14. Loosen the screw (1) further by approx. ¼ turn.

15. Tap on ESC.

16. Tap on Kalibrierung 3 (Calibration 3).

17. Hold the screw (1) still with a screwdriver, and tighten the nut (2). 
Once again, take care the disk (3) does not turn with the nut.

18. Tap on ESC and check that the tension disks (4) open easily.

19. Tap on Kalibrierung 1 (Calibration 1) and check the closure 
of the tension disks.

20. Repeat the procedure for the 2nd thread tensioner.

4.7.4 Calibrating the thread tension plate

Fig. 44: Calibrating the thread tension plate

To calibrate the thread tension plate:

1. Thread the thread 8/3 times and on to the thread lever (5).

2. With Kalibrierung 1 (Calibration 1) selected, measure the 
thread tension with a thread scale (6).

3. Input the measured value into the control and confirm it with OK.

4. Perform the measurement and input also for Kalibrierung 2 
(Calibration 2) and Kalibrierung 3 (Calibration 3).

(1) - Thread lever (2) - Thread scale

①

②
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Checking the calibration

1. Input the percentage value = 50 in the Fadenspannung (Thread 
tension) menu.

2. Press the Ein (On) button to switch on the tension.

3. Test the tension using a thread scale: Setpoint: 1000 cN. 
If necessary, other percentage values can be input.

4. If variations ±10 % are found: Set the thread tensioners once again 
and repeat the calibration.

5. If the variations persist: Clean any dirt from the thread tensioners includ-
ing the magnets.

4.8 Thread cutter

4.8.1 Setting the height of the thread-pulling knife

The height of the thread-pulling knife is factory-set such that the distance (5) 
between the upper edge of the knife carrier (4) and the hook bearing screw-
on surface (3) is 10.7 ± 0.05 mm. Fine adjustment is made by means of 
washers between the knife carrier (4) and the thread-pulling knife (2).

Important

When changing the knives, make sure that you do not lose the washers.

Proper setting

The thread-pulling knife (2) pivots as close as possible above the hook 
and is at the same height as the counter blade (1).

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch the machine off before you check and set 
the height of the thread-pulling knife.
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Fig. 45: Setting the height of the thread-pulling knife

To set the height of the thread-pulling knife:

1. Loosen the screw (6).

2. Remove the thread-pulling knife (2).

3. Place as many washers between thread-pulling knife (2) and knife 
carrier (4) as necessary to ensure that the upper edges of counter 
blade (1) and thread-pulling knife (2) are at the same height.

4. Non-required washers on the top side between the thread-pulling 
knife (2) and screw (6) should be kept.

5. Screw down the thread-pulling knife (2) using screw (6).

(1) - Counter blade
(2) - Thread-pulling knife
(3) - Hook bearing

(4) - Knife carrier
(5) - Distance
(6) - Screw

6

4

1
2

3

5
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4.8.2 Setting the cutoff curve

Proper setting

The control cam (4) makes direct contact with the clamping ring (1). 

The distance between the widest extent (6) of the control cam (4) and the 
roller (3) is 0.1 mm at most.

In resting position, the circle mark on the cutting edge of the thread-pulling 
knife is exactly next to the tip of the counter blade.

Cover

• Swivel up the machine head ( p. 15)

• Bobbin flap ( p. 21)

Fig. 46: Setting the cutoff curve (1)

To set the cutoff curve:

1. Loosen all 4 threaded pins (2) on the clamping ring (3).

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you set the cutoff 
curve.

(1) - Roller
(2) - Threaded pins
(3) - Clamping ring
(4) - Control cam
(5) - Threaded pins

(6) - Highest point
(7) - Clamping screws
(8) - Actuating lever
(9) - Solenoid

③ ④
⑤

⑥

⑦

⑧

⑨

①

②
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2. Push the clamping ring (3) towards the hook bearing as far as it will go.

3. Tighten all 4 threaded pins (2) on the clamping ring (3). 
The clamping ring (3) and control cam (4) are both mutually used as 
a stop and should not be loosened at the same time.

4. Loosen the threaded pins (5).

5. Press the actuating lever (8) against the solenoid (9).

6. Turn the control cam (4) until its highest point is next to the roller (1).

7. Move the control cam (4) such that the distance between its highest 
point (6) and the roller (1) is 0.1 mm at most.

8. Tighten the threaded pins (5).

9. Loosen the clamping screw (7) on the actuating lever (8).

Fig. 47: Setting the cutoff curve (2)

10. Turn the thread-pulling knife (12) such that the circle mark is exactly 
next to the tip of the counter blade (11).

11. Tighten the clamping screw (7) on the actuating lever (8) such that the 
actuating lever (8) has no axial play.

12. Loosen all 4 threaded pins (2) on the clamping ring (3).

13. Push the clamping ring (3) to the right as far as it will go and against 
the control cam (4).

Important

Check the loop stroke position ( p. 34).

14. Tighten all 4 threaded pins (2) on the clamping ring (3).

(10) - Screw
(11) - Counter blade
(12) - Thread-pulling knife

(13) - Screw
(14) - Hook thread clamp
(15) - Screw

<

0

,
.

+

^
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4.8.3 Setting the cutting pressure

The shape of the thread-pulling knife automatically creates the required 
cutting pressure as soon as the thread-pulling knife and counter blade 
make contact.

Proper setting

In resting position, the hook thread clamp makes contact with the thread-
pulling knife without any pressure being applied. Any 2 threads with the 
greatest strength used for sewing can be neatly cut simultaneously.

Disturbances caused by an incorrect setting

• Increased knife wear when the pressure is too great

• Problems when sewing if the hook thread clamp is too high

• Problems in cutting the thread

Cover

• Bobbin flap ( p. 21)

Fig. 48: Setting the cutting pressure

To set the cutting pressure:

1. Press and turn the hand crank until the thread-pulling knife (3) can be 
swung out by hand.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before setting the cutting 
pressure.

(1) - Screw
(2) - Counter blade
(3) - Thread-pulling knife

(4) - Screw
(5) - Hook thread clamp
(6) - Screw

1

3
2 5

6

4
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2. Loosen the screw (1).

3. Position the thread-pulling knife (3) such that the arrow mark is exactly 
next to the tip of the counter blade (2).

4. Turn the hook thread clamp (5) such that it rests against the thread-
pulling knife (3). 

5. Turn the counter blade (2) such that it rests against the thread-pulling 
knife (3).

6. Tighten the screw (1).

Important

Check the position of the cutters, since the counter blade can easily be-
come warped when the screw is being tightened.

4.8.4 Setting point in time for cutting

Proper setting

The threads are cut when the thread lever is at the top dead center.

Cover

• Swivel up the machine head ( p. 15)

• Bobbin flap ( p. 21)

Fig. 49: Setting point in time for cutting

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the point in time for cutting.

(1) - Roller 
(2) - Clamping ring
(3) - Control cam

(4) - Threaded pins
(5) - Counter blade
(6) - Thread-pulling knife

6

1

2 3

54
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To set the point in time for cutting:

1. Loosen the threaded pins (4).

2. Press and turn the hand crank until the thread-pulling knife (6) can be 
swung out by hand.

3. Pivot the thread-pulling knife (6) as far forward until the circle mark is 
exactly next to the tip of the counter blade (5).

4. Press and turn the hand crank until the thread lever is at the top dead 
center.

5. Push the control cam (3) to the left as far as it will go and against the 
clamping ring (2).

6. Turn the control cam (3) such that the roller (1) runs up at the contour 
of the control cam (3) and the widest extent of the control cam is at the 
highest point when the thread lever is at the top dead center.

7. Tighten the threaded pins (4).

8. Check the setting:

• Insert the thread into thread-pulling knife (6) and slowly press and 
turn the hand crank.

• Determine the hand crank position at which the thread is cut.

• Repeat setting steps 1 – 7 if necessary.
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4.9 Thread burner (optional)

4.9.1 Setting the upper thread burner

Proper setting

The burner burns the thread off cleanly without damaging the sewing ma-
terial. The burner pivots quickly without coming into contact with the stop.

Cover

• Burner cover ( p. 23)

To set the upper thread burner:

1. Tap on Extras > Service > Multitest.

2. Tap on Fadenbrenner (Thread burner).

3. Tap on Klammer schließen (Close clamp).

4. Use Brenner oben runter (Upper burner down) to check the 
movement sequence.

Fig. 50: Setting the upper thread burner

 Both threads (1) are burnt off and sucked in. The burner (2) is posi-
tioned slightly to the left opposite the needle hole.

(1) - Threads (2) - Thread burner

① ②
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Setting the height

Fig. 51: Setting the height (1)

(1) - Threaded pin (2) - Nut

②

①
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Fig. 52: Setting the height (2)

To set the height of the thread burner:

1. Slightly loosen the nuts (4).

2. Position the bracket (3) at the desired bottom limit.

3. Re-tighten the nuts (4).

4. Use the threaded pin (1) to set the upper limit such that there is as little 
play as possible when the thread burner is at its topmost position. 
Lock the upper limit with a nut (2).

5. Insert the sewing material.

6. Check the movement sequence.

7. Set the material thickness scanner in relieved condition if necessary:

• Loosen the screws (5) and adjust the height of the material thick-
ness scanner (6).

• Tighten the screws (5).

(3) - Bracket (4) - Nuts

④③
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Fig. 53: Setting the height (3), setting the material thickness scanner

Setting the needle thread advancing device

Proper setting

The needle thread advancing device pivots quickly while advancing and 
slightly pulling back the thread at the same time. It positions the thread for 
the suction device. When being burnt off, the thread is not under tension.

Fig. 54: Setting the needle thread advancing device (1)

(5) - Screws (6) - Material thickness scanner

⑤

⑥

(1) - Screwdriver
(2) - Screw

(3) - Needle thread advancing device

③

①

②
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Fig. 55: Setting the needle thread advancing device (2)

To set the needle thread advancing device:

1. Loosen the screw (2). 

2. Move the needle thread advancing device (3) such that it passes over 
the clamp and under the sewing foot when completing its forward 
motion.

3. Tighten the screw (2).

4. Use the stop screw (4) to limit the swivel angle.

(4) - Stop screw

④
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Setting the position of the burner tip

Fig. 56: Setting the position of the burner tip

To set the position of the burner tip:

1. Loosen the screws (1).

2. Adjust the length of the burner tip (2).

3. Tighten the screws (1).

4. Use the screws (3) to make a height adjustment if necessary.

(1) - Screws
(2) - Burner tip

(3) - Screws

①
②

③
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Setting the throttle valves

Fig. 57: Setting the throttle valves

1. Set the throttle valves (1, 2).

Setting the thread suction device

Proper setting

The thread suction device reliably sucks in the thread. Even though 
positioned closely to the swung-out needle thread advancing device, the 
thread suction device does not interfere with the swivel motion performed 
by the needle thread advancing device.

Fig. 58: Setting the thread suction device

(1) - Throttle valve - upward movement (2) - Throttle valve - downward movement

①

②

(1) - Angle bracket with screws

①
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To set the thread suction device:

1. Depending on the clamping system used, set the position of the thread 
suction device using the screws on the angle bracket (1).

4.9.2 Setting the lower thread burner

Proper setting

The burner burns the thread off cleanly without damaging the sewing ma-
terial. The movement is quick.

Cover

• Swivel up the machine head ( p. 15)

Fig. 59: Setting the lower thread burner

To set the lower thread burner:

1. Loosen the screws (2).

2. Tap on Extras > Service > Multitest.

3. Tap on Fadenbrenner (Thread burner).

4. Tap on Klammer schließen (Close clamp).

5. Use Brenner unten rauf (Lower burner up) to check the 
movement sequence.

6. Adjust the height of the thread burner holder until the thread burner tip 
is positioned closely under the throat plate.

7. Tighten the screws (2).

8. Loosen the screws (3).

9. Move the thread burner holder sideways until the thread burner tip is 
positioned in the center, as seen from the top through the needle hole.

10. Tighten the screws (3).

11. Set the throttle valves (4, 5).

12. Check and, if necessary, set the movement sequence again.

(1) - Thread burner tip
(2) - Screws
(3) - Screws

(4) - Throttle valve - upward movement
(5) - Throttle valve - downward movement

③ ④

⑤

①

②
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4.9.3 Replacing the thread burner tips

Cover

• Burner cover ( p. 23)

• Swivel up the machine head ( p. 15)

Fig. 60: Replacing the thread burner tips

To replace the thread burner tips:

1. Loosen the screws (1).

2. Change the burner tips (2).

3. Tighten the screws (1).

4. Tap on Extras > Service > Multitest > Fadenbrenner 
(Thread burner).

5. Use Brenner an (Burner on) to verify that the burner tip is glowing 
(turns off automatically after 10 s). 

WARNING

Risk of injury from hot thread burner tip

Risk of burns.

NEVER touch the thread burner tip.

(1) - Screws (2) - Thread burner tip

①

②
①
②
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4.9.4 Setting the thread advancing device

Fig. 61: Setting the thread advancing device

Proper setting

• When the thread advancing device (1) is at rest, the distance between 
the highest point of the control cam (6) and the roller (5) is 0.1 mm

• The control cam (6) makes contact with the clamping ring (4)

• The carrier (2) must have no axial play, but still run smoothly

Setting steps

1. Loosen all 4 threaded pins on the clamping ring (4).

2. Push the clamping ring (4) towards the hook bearing as far as it will go. 

3. Tighten all 4 threaded pins on the clamping ring (4).

4. Loosen both threaded pins on the control cam (6).

5. Turn the lever (7) so that the threaded pin (9) on the body casting (3) 
strikes the hook support.

6. Set the distance between the roller (5) and the highest point of the 
control cam (6) to 0.1 mm.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the thread advancing device.

(1) - Thread advancing device
(2) - Carrier
(3) - Body casting
(4) - Clamping ring
(5) - Roller

(6) - Control cam
(7) - Lever
(8) - Clamping screw
(9) - Threaded pin

⑧

⑨

①

② ③ ④ ⑤ ⑥ ⑦
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7. Tighten both threaded pins on the control cam (6).

8. Loosen the clamping screw (8) on the lever (7).

9. Turn the thread advancing device (1) until the bobbin can be removed.

10. Tighten the clamping screw (8). Take care to ensure that there is no 
axial play.

11. Loosen all 4 threaded pins on the clamping ring (4) and push the clamp-
ing ring as far as it will go and against the control cam (6).

12. Tighten all 4 threaded pins on the clamping ring (4).

13. Check the loop stroke.

Setting the locking latch

Fig. 62: Setting the locking latch

(1) - Magnet armature
(2) - Locking latch
(3) - Threaded pin
(4) - Nut

(5) - Roller
(6) - Control cam
(7) - Locking pin

①

②

③

④

⑤

⑥

⑦
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Proper setting

1. Press and turn the hand crank until the roller (5) is at the highest point 
of the control cam (6).

2. Press against the magnet armature (1).

 The locking latch (2) can be swung out without clamping, and the dis-
tance between the locking latch (2) and locking pin (7) is not greater 
than 0.1 mm.

To set the locking latch:

1. Loosen the nut (4).

2. Turn the threaded pin (3) and set the distance.

3. Tighten the nut (4).

4.10 Setting the hook thread clamp

Cover

• Swivel up the machine head ( p. 15)

• Bobbin flap ( p. 21)

Fig. 63: Setting the hook thread clamp

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the hook thread clamp.

(1) - Magnet armature
(2) - Thread advancing device

(3) - Hook thread clamp

① ② ③
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Proper setting

The thread is held in place, but not clamped.

To set the hook thread clamp:

1. Press against the magnet armature (1) while pressing and turning the 
hand crank until the thread advancing device (2) swings out.

2. Insert the end of the hook thread into the thread advancing device.

3. Press and turn the hand crank until the cutter swings back.

4. Check if the thread is held in place without being clamped.

4.11 Setting the control cam of the thread advancing device

Fig. 64: Setting the control cam of the thread advancing device

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before you check and set 
the control cam of the thread advancing device.

(1) - Control cam (2) - Threaded pins

①

②
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Proper setting

The thread advancing device is in its idle position when at the position 
thread lever at top dead center. When the machine is at the position thread 
lever at top dead center the control cam (1) is at its highest point.

The thread advancing device captures the hook thread, but not the needle 
thread. If there are any short pieces of thread in the area of the hook that 
have been burnt off on both sides, the thread advancing device will cap-
ture the needle thread as well. In this case, the control cam will have to be 
corrected to allow the thread advancing device to swing out with a delay.

To set the control cam of the thread advancing device:

1. Press the hand crank and turn it to the position "thread lever at top 
dead center".

2. Loosen the threaded pins (2).

3. Rotate the control cam (1).

4. Tighten the threaded pins (2).
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4.12 Changing the cloth pressure bar

Cover

• Motor cover ( p. 16)

Fig. 65: Changing the cloth pressure bar (1)

Disassembling the cloth pressure bar

To disassemble the cloth pressure bar:

1. Loosen the threaded pins (2) and pull the bearing with the gear 
wheel (1) out towards the front.

2. Dismantle the drive (3).

3. Loosen all 3 screws (4) and remove the drive shaft.

4. Loosen the screw (5).

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch the machine off before you disassemble or 
assemble the cloth pressure bar.

(1) - Bearing with gear wheel
(2) - Threaded pins
(3) - Drive

(4) - Screws
(5) - Screw

①

②
③

④ ⑤
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Fig. 66: Changing the cloth pressure bar (2)

5. Position the clip (7) so that the screw (7) is accessible.

6. Loosen the screw (10) and take off the clip (7).

7. Pull the sleeve (10) out.

8. Pull the clamp (6) right up to the top and pull the cloth pressure bar (8) 
out upwards.

Assembling the cloth pressure bar

To assemble the cloth pressure bar:

1. Assemble in reverse of removal.

Order

After the drive (3) has been tightened, set the sewing foot height ( p. 53).

(6) - Block
(7) - Clip
(8) - Cloth pressure bar

(9) - Sleeve
(10) - Screw

⑥

⑦

⑧

⑨

⑩
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5 Sewing unit

5.1 Checking the machine zero point

The machine zero point is factory-set to the correct value.

Fig. 67: Checking the machine zero point

Gage required: Clamp with test bore.

To check the machine zero point:

1. Tap on Extras > Service > Multitest.

2. Tap on Transportklammer (Feed clamp).

3. Assemble the clamp (1).

4. Tap on Referenzieren (Move to reference position).

 The machine moves to the reference position.

5. Tap on Mittelpunkt (Center point).

 The machine moves to the center position. The needle is positioned 
within the center point bore (2), and the tip of the needle can be low-
ered into the bore by turning the arm shaft crank.

6. Tap on Test.

 The machine moves to the test position. The center of the needle is 
positioned within the test bore (3), and the tip of the needle can be 
lowered into the bore by turning the arm shaft crank.

(1) - Clamp with test bores
(2) - Center point bore

(3) - Test bore

③

①

②
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5.2 Changing the drives

5.2.1 Changing the sewing motor

Disassembling the sewing motor

To disassemble the sewing motor:

1. Cut off the cable ties.

2. Disconnect the motor cable from the control.

3. Removing the toothed belt cover ( p. 20).

Fig. 68: Disassembling the sewing motor

4. Loosen the screws (6).

5. Remove the toothed belt (1).

6. Pull off the plate (3) with the motor (4).

7. Remove the toothed belt wheel (2). 
To do so, loosen the screw on the toothed belt wheel.

8. Loosen the screws (5).

9. Remove the motor (4) from the plate (3).

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch off the machine before changing the drives.

(1) - Toothed belt
(2) - Toothed belt wheel
(3) - Plate

(4) - Motor
(5) - Screws
(6) - Screws

④

⑥

③

①
⑤②
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Assembling the sewing motor

Fig. 69: Assembling the sewing motor

To assemble the sewing motor:

1. Screw the new motor (4) onto the plate (3) using the screws (5).

2. Assemble the toothed belt wheel (2). 
To do so, tighten the screw on the toothed belt wheel.

3. Insert the plate (3) with the motor (4).

4. Slightly tighten the screws (6).

5. Place and tighten the toothed belt (1).

Information

The toothed belt tension is set to the optimum value when the belt oscil-
lates at 284 Hz. Check the oscillation, for instance, using a device made 
by Contitech.

6. Tighten the screws (6).

7. Check if the toothed belt (1) operates in parallel. 
If necessary, set parallel operation at the toothed belt wheel.

8. Place the toothed belt cover ( p. 20).

9. Connect the motor plug with the control.

(1) - Toothed belt
(2) - Toothed belt wheel
(3) - Plate

(4) - Motor
(5) - Screws
(6) - Screws

④

⑥

③

①
⑤②
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5.2.2 Changing the X drive

Fig. 70: Changing the X drive

Disassembling the X drive

To disassemble the drive:

1. Disconnect both plugs (4).

2. Loosen all 4 screws (1).

3. Pull off the motor and flange (3).

Assembling the X drive

To assemble the drive:

1. Insert a new motor and flange (3) on to the toothed belt (2).

2. Insert all 4 screws (1) and tighten them loosely.

3. Tension the toothed belt (2) using the screw (5).

Information

The toothed belt tension is set to the optimum value when the belt oscil-
lates at 384 Hz. Check the oscillation, for instance, using a device made 
by Contitech.

4. Tighten all 4 screws (1).

5. Connect the plug (4).

(1) - Screws
(2) - Toothed belt
(3) - Motor with flange

(4) - Plug
(5) - Screw

④

⑤

①

②

③
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5.2.3 Changing the Y drive

Fig. 71: Changing the Y drive

Disassembling the Y drive

To disassemble the drive:

1. Disconnect the plug (1).

2. Unscrew the equipotential bonding (4).

3. Loosen the screw (3) to release the toothed belt (5) tension.

4. Loosen all 4 screws (2).

5. Pull the motor (6) off the flange (7).

6. Pull off the toothed belt wheel.

Assembling the Y drive

To assemble the drive:

1. Place the toothed belt wheel onto the new motor. 

2. Insert the motor (6) into the toothed belt (5) and onto the flange (7).

3. Insert all 4 screws (2) and tighten them loosely.

4. Tension the toothed belt (5) using the screw (3) (185 Hz).

Information

The toothed belt tension is set to the optimum value when the belt oscil-
lates at 185 Hz. Check the oscillation, for instance, using a device made 
by Contitech.

(1) - Plug
(2) - Screws
(3) - Screw
(4) - Equipotential bonding

(5) - Toothed belt
(6) - Motor
(7) - Flange

⑦

④ ⑤ ⑥

①

②

③
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5. Tighten all 4 screws (2).

6. Connect the plug (1).

7. Tighten the potential bonding (4).

5.3 Checking the play between toothed rack and gear wheel

The play between the toothed rack and the gear wheel must be checked 
on both sides of the machine. Because the structure is similar on both 
sides, testing is described here for one side only as an example.

Fig. 72: Checking the play between toothed rack and gear wheel

Proper setting

There should be no play between the gear wheel (1) and toothed rack (2).

To check the play between toothed rack and gear wheel:

1. Loosen the screw (4).

2. Turn the nut (3) so that there is no play.

3. Tighten the screw (4).

4. Check the play along the entire length.

 The carriage can be moved without excessive play or stiffness.

(1) - Gear wheel
(2) - Toothed rack

(3) - Nut
(4) - Screw

①

②

③

④
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6 Programming 

The control is operated via the operating terminal (1) that is found next to 
the machine head.

Fig. 73: Operating the control

The screen is a touchscreen, i.e. the buttons are displayed on the screen 
rather than using physical buttons. Buttons or functions are activated by 
tapping the corresponding position on the monitor.

Activating a button/selecting an element:

1. Tap the corresponding button or element with your finger or a touch-
screen pen.

(1) - Operating terminal

①
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6.1 Structure of the software

The software allows the creation and management of seam programs and 
sequences. During sewing, these programs are called up and processed 
stitch by stitch. 

Seam program:

A seam program consists of a seam contour with parameters defining the 
individual contour sections.
Up to 99 seam programs can be stored in the system.
Seam programs have a file suffix of .fnp911 after the filename.

Sequence:

Up to 30 seam programs can be combined in any order to form a sequence.
Up to 20 sequences can be stored in the system.
Sequences have a file suffix of .seq911 after the filename.

The software is also used to define general settings that apply to all pro-
grams. There are also technical menu items for testing and maintaining 
the machine.

6.2 Overview of the menu structure

The following table provides an overview of the menu structure and the 
function buttons on the start screen.

Different colors indicate which functions are mainly used for normal sew-
ing operations, which items are used for creating and maintaining seam 
programs and the menu items that are used for making technical settings.

Green: Menu items for sewing

Blue: Menu items for creating and managing programs

Magenta: Menu items for technician settings and information (can only be 
opened with password)

Menu items in popup menus

Menu item Function Subitems Subitems Described on

File Open existing sewing 
programs, create new 
programs, copy or delete 
existing programs.

Löschen (Delete)  p. 72

Kopieren (Copy)  p. 56

Öffnen (Open)  p. 43

Neu (New) Nahtprogramm 
(Seam program)

 p. 48

Sequenz (Sequence)  p. 52

Speichern unter 
(Save As)

 p. 55
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Bearbeiten 
(Edit)

Define general settings 
for all programs or 
modify an existing 
program.

Maschinenparameter 
(Machine 
Parameters)

 p. 66

Sequenz (Sequence)  p. 66

Nahtprogramm 
(Seam program)

Parameter  p. 60

Konturanpassung 
(Contour 
Adjustment)

 p. 60

Konturtest 
(Contour Test)

 p. 51

Extras Display options: full-
screen and zoom

Technician menu: 
Settings, system 
information and tests

Vollbild ein/aus (Full-
screen on/off)

 p. 42

Zoom ein/aus (Zoom 
on/off)

 p. 42

Service 
(nur mit Passwort - 
only with password)

Einstellungen 
(Settings)

 p. 72

System-Information 
(System Information)

 p. 79

Multitest  p. 72

Initialisierung 
(Initialization) 
und Update 
(and update)

 p. 80

Manufacturer (for DA personnel only)

Korrektur 
(Correction)

Short-term sewing with 
other values

Fadenspannung 
(Thread tension)

 p. 44

Nähdrehzahl (Speed)  p. 45

Buttons on the start screen

Continue sewing the contour from a particular 
point

Reparatur-Modus 
(Repair mode)

 p. 47

Allow for a manual bobbin change Spulenwechsel 
(Bobbin change)

 p. 45

Reset counter to a particular value Zählerreset (Reset 
counter)

 p. 47

Menu items in popup menus

Menu item Function Subitems Subitems Described on
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6.3 Starting the software

After being switched on at the main switch, the machine needs to be ref-
erenced. After this, the start screen is shown on the operating terminal for 
a few seconds.

Fig. 74: Starting the software

Here you can select the user interface language or use Service to 
quickly access the Multitest menu.

Information

Both functions can also be accessed later from within the program via 
Extras > Service. 
(See chapters Testing the functions of the machine ( p. 133) and 
Changing the language ( p. 132))

If you do not tap any buttons, the software automatically switches to the 
start screen after a few seconds.

(1) - Button language selection (2) - Multitest quick-access button

① ②
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The start screen

The start screen is displayed during sewing. When the machine is started, 
the start screen is opened with the settings of the last sewing program 
used.

Fig. 75: Start screen

Structure of the start screen

Title bar (1)

This shows the version of the machine on the start screen. It also contains 
information on the menu item currently selected in the various menus.

Status bar (2)

On the start screen, the sequence currently open is displayed here, and 
the time of day (11) is displayed at the right. It also bar contains informa-
tion on the currently selected step in the various menus.

Main window (3)

The contour to be sewn is displayed here.

Program bar (4)

The seam programs of the sequence currently open are displayed here. 
The program currently being executed is highlighted in black. The arrow 
buttons (6) at the right side of the bar can be used to navigate along the 
bar and display any additional programs that do not fit on the bar.
If a sequence is not currently open but rather only a single seam program 
then this program fills the entire bar.

(1) - Title bar
(2) - Status bar
(3) - Main window Display of the 

seam contour
(4) - Program bar
(5) - Menu bar: Popup menu

(6) - Arrow buttons for navigating within the bar
(7) - Button for resetting the counter
(8) - Button for bobbin change
(9) - Display of the current seam parameters
(10) - Button for repair mode
(11) - Display of time

①
②

③

④
⑤ ⑥

⑦
⑧
⑨

⑩
⑪
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Menu bar (5)

The bar at the bottom contains the popup menus. This allows you to ac-
cess the various different menu items for creating and editing seam pro-
grams and for performing settings and tests on the machine. An arrow (1) 
next to a menu entry indicates that tapping the entry will display further 
subitems.

Fig. 76: Popup menu

Button for repair mode (10)

The topmost button at the right side is used for switching the repair mode 
on and off. The current status (Ein (On)/Aus (Off)) is displayed 
next to the button.

Display of the current seam parameters (9)

The current seam parameters are displayed below the repair mode button

•  - Dimensions of the seam

•  - Speed

•  - Thread tension

•  - Number of stitches / hook thread consumed

(1) - Popup arrows

①
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Fig. 77: Start screen

Button for bobbin change (8):

This button is used to inform the system that a new bobbin has been in-
serted (e.g. after a color change). The hook thread capacity is displayed 
next to this button.

Button for resetting the counter (7):

This button can be used for resetting the counter for the sewn programs 
or sequences. The current counter value is displayed next to this button.

(1) - Title bar
(2) - Status bar
(3) - Main window Display of the 

seam contour
(4) - Program bar
(5) - Menu bar: Popup menu

(6) - Arrow buttons for navigating within the bar
(7) - Button for resetting the counter
(8) - Button for bobbin change
(9) - Display of the current seam parameters
(10) - Button for repair mode
(11) - Display of time

①
②

③

④
⑤ ⑥

⑦
⑧
⑨

⑩
⑪
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6.4 General operation of the software

6.4.1 Entering a password

Depending on the setting (see chapter Changing the password options 
( p. 131)) a password is only required for accessing the technical 
menus or must be entered every time the machine is started. The pass-
word entry screen is displayed when a password is required.

Fig. 78: Entering a password

Entering a password

To enter a password:

1. Use the numeric buttons (2) to enter the password.

Information

The default password on delivery is: 25483.
The password can be changed via the Extras menu ( p. 131).
You can delete incorrect entries via the DEL button.

2. Tap the OK button.

 The previously selected menu item opens.

(1) - Input field (2) - Numeric buttons

①

②
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6.4.2 Closing windows

A number of different buttons can be used for closing the currently open 
window.

6.4.3 Display principles

Fig. 79: Display principles

The currently activated or selected element is highlighted with a dark 
background (2).

Buttons that are not used in the current context are grayed-out (1).

Button Meaning

At the upper right in the title bar of all windows:
 The program jumps back by one navigation level.

OK
CR

In windows with data entry or selection fields:
 The window is closed, and the entered 

or selected data is adopted. 

DEL
Cancel
Cancel

In windows with data entry or selection fields:
 The window is closed, and the entered 

or selected data is discarded. 

(1) - Grayed-out: Deactivated element (2) - Dark background: Activated element

②

①
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6.4.4 Scrolling the display

Fig. 80: Scrolling the display

A scrollbar (1) is displayed on the right when a displayed image is larger 
than the screen height.

Moving image up/down

To move the image up or down:

1. Drag the scrollbar (1) up or down.

6.4.5 Selecting options from a list

When selecting options, a distinction is made between round option buttons 
and square checkboxes.

Selection with option buttons

Fig. 81: Selection with option buttons

With round option buttons only one of the displayed options can be selected.

(1) - Scrollbar

①

(1) - Option buttons: Selected element

①
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To select options using checkboxes:

1. Tap the desired option.

 The selected option (1) is marked with a dot.

Selection with checkboxes

Fig. 82: Selection with checkboxes

Checkboxes allow for the selection of multiple entries.

To select options using checkboxes:

1. Tap the desired checkboxes.

 The selected entries (1) are marked with a cross.

6.4.6 Using file filters

When opening, copying or deleting seam programs a list of all available 
files is displayed.

You can use the filter functions to make the list more manageable:

To use file filters:

1. Tap the File Filter button under the list.

 The file filter screen opens.

(1) - Checkbox: Selected elements

①
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Fig. 83: File filter

2. Tap the desired filter criterion:

• .fnp911: Seam programs only

• .seq911: Sequences only

• All Files: Seam programs and sequences

3. Tap the Öffnen (Open) button.

 The list is updated according to the selected filter:

6.4.7 Entering text

A text entry window is displayed when text needs to be entered, e.g. for 
the name of a program.

Fig. 84: Entering text

Entering text

1. Use the keyboard (2) displayed to enter the text.

(1) - Input line
(2) - Keyboard
(3) - OK (CR): Adopt the entered text

(4) - DEL: Delete a character
(5) - Aa: Switch between uppercase/lowercase

①

②

③
④
⑤
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Switch between uppercase/lowercase

1. Tap the Aa (5) button.

Delete the last character

1. Tap the DEL (4) button.

Adopt the entered text

1. Tap the OK (CR) (3) button.

 The entered text is adopted, and the text entry window is closed.

6.4.8 Entering parameter values

A numeric entry window opens when numeric values for program or ma-
chine parameters need to be entered.

Fig. 85: Entering parameter values

The title bar (1) shows the parameter group.

The status bar (2) shows the name of the parameter currently being edit-
ed. The symbol (3) for the corresponding parameter is display below the 
parameter name.

The prescribed value range (4) for the parameter is displayed below the 
symbol (3).

The current valid value is displayed in the data entry field (5) below the val-
ue range (4).

Entering a value

1. Tap the desired numeric buttons (6).

(1) - Title bar
(2) - Status bar
(3) - Symbol

(4) - Value range
(5) - Input field
(6) - Numeric buttons

①

②
③
④
⑤

⑥
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Deleting a value

1. Tap the DEL button.

Adopting a value

1. Tap the OK button.

 The entered value is adopted, and the numeric entry window is closed.

6.4.9 Switching the full-screen display on and off

In order to see the seam contour in more detail you can switch the main 
window (1) to occupy the full screen and hide the buttons (2) on the right 
side of the start screen.

Fig. 86: Switching the full-screen display on and off

To switch full-screen on and off:

1. Tap the menu items Extras > Vollbild ein/aus
(Full-screen on/off).

 The display switches to the respective other mode.

(1) - Full-screen switched off (2) - Full-screen switched on

① ②
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6.4.10 Switching zoom on and off

You can magnify the display in order to see the seam contour in more de-
tail. There is only one zoom level that can be switched on or off.

Fig. 87: Switching zoom on and off

To switch zoom on and off:

1. Tap the menu items Extras > Zoom ein/aus (Zoom on/off).

 The display switches to the respective other mode.

6.5 Opening a seam program or sequence for sewing

You will usually open an existing seam program or an existing sewing 
sequence.

To open a seam program or sewing sequence:

1. Tap the menu items Datei (File) > Öffnen (Open).

 The file selection screen is displayed.
All existing seam programs and sequences are displayed.

Information

You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 100).

(1) - Zoom switched off (2) - Zoom switched on

① ②
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Fig. 88: Opening a seam program or sequence for sewing

2. Tap the desired file.

3. Tap the Öffnen (Open) button.

 The seam program/sequence is opened on the start screen.

4. Press the pedal forwards to start sewing.

6.6 Briefly sewing with modified values

If you briefly need to with sew a special material or use a particular thread 
strength with different values, without changing the seam program, you 
can use the Korrektur (Correction) menu item to temporarily 
change the values for thread tension and speed. The values then apply to 
all subsequently executed seams until the machine is switched off. 

Important

If you wish to adopt the changes then you must modify and save the 
program. Otherwise the values are automatically reset to the previous 
settings when the machine is switched off. 
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6.6.1 Sewing with a modified thread tension

To sew with a modified thread tension:

1. Tap the menu items Korrektur (Correction) > Faden-
spannung (Thread Tension).

 The window for changing the thread tension appears:

Fig. 89: Sewing with a modified thread tension

2. Enter the desired thread tension value.

3. Tap the OK button.

 The value is adopted and used for all seams until the machine is 
switched off.

6.6.2 Sewing with a modified speed

To sew with a modified speed:

1. Tap the menu items Korrektur (Correction) > Nähdre-
hzahl (Speed).

 The window for changing the thread tension appears:

Fig. 90: Sewing with a modified speed

2. Enter the desired speed.
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3. Tap the OK button.

 The value is adopted and used for all seams until the machine is 
switched off.

6.7 Replacing the hook thread bobbin

The machine automatically detects when the hook thread has been used 
up and a new bobbin needs to be inserted.

In this case, or if thread breakage occurs, the Fadenriss behandeln 
(Manage Thread Breakage) window is automatically displayed.

Fig. 91: Replacing the hook thread bobbin

To change the hook thread bobbin:

1. Tap the Spulenwechsel (Change Bobbin) button.

2. Replace the hook thread bobbin

3. Use the Vor (Forwards) and Zurück (Back) buttons to move to the 
point where sewing is to continue.

4. Tap the Weiternähen (Continue Sewing) button.

 The program jumps back to the start screen and sewing of the seam 
continues from the selected point.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch the machine to threading mode before 
changing the hook thread bobbin.
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Bobbin change without a request from the program

If you wish to independently insert a new bobbin without being requested 
to do so by the program, e.g. when changing color, then you have to tap 
the Spulenwechsel (Bobbin Change) button on the start screen after 
changing the bobbin to inform the program that a new bobbin has been in-
serted and that thread consumption should resume from the value corre-
sponding to the full bobbin capacity.

Updating the bobbin capacity

To update the bobbin capacity:

1. Tap the button  Spulenwechsel (Bobbon Change) on the 
start screen.

 The counter for the bobbin capacity begins anew with a full bobbin.

6.8 Continuing a seam in Repair mode after an error

In Repair mode you can move to any desired point on the contour, e.g. in 
order to continue the seam program from this position after an error has 
occurred.

To continue a seam in Repair mode after an error:

1. Tap the button  Reparaturmodus (Repair mode) on the 
start screen.

 The Reparaturmodus (Repair mode) window is displayed.

Fig. 92: Continuing a seam in Repair mode after an error

2. Use the Vor (Forwards) and Zurück (Back) buttons to move to the 
point where sewing is to continue.

3. Tap the Weiternähen (Continue Sewing) button.

 The program jumps back to the start screen and sewing of the seam 
continues from the selected point.
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6.9 Resetting the counter

Depending on the machine parameter settings, the counter counts the 
sewn programs or sequences up or down. You can use the Zähler-Reset 
(Reset Counter) button to reset the counter to the start value ( p. 130).

To reset the counter:

1. Tap the button  Zähler-Reset (Reset Counter) on the start 
screen.

 The counter is reset to the value defined in the machine parameters.

6.10 Creating a new seam program

New seam programs are created using a Teach-In procedure. 

Individual seam paths with specific seam parameters are defined via the 
operating terminal in order to do this.

To create a new seam program:

1. Tap the menu items Datei (File) > Neu (New) > 
Nahtprogramm (Seam Program).

 The Teach-In window appears.

Fig. 93: Creating a new seam program

(1) - Cursor position
(2) - Cursor
(3) - Arrow buttons
(4) - OK button: Übernahme (Accept)

(5) - Speichern (Save) button
(6) - Löschen (Delete) button
(7) - Parameter button
(8) - Linienauswahl (Line selection) button

②

③ ④
⑤
⑥
⑦

⑧

①
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Defining the starting point

2. Define the starting point:

3. Tap the OK (4) button.

 The desired starting point is adopted and marked with a green dot.

Selecting the line type

4. Use the line selection buttons (8) to select the type of line to be defined.

•   Seamless path: 
The clamps move over this path to the next position without sewing.

•   Straight seam: 
A straight path is sewn.

•   Curved seam: 
A curve is sewn.

 After tapping the button for a straight or curved seam the correspond-
ing window for entering the seam parameters for this path opens.

Method Coordinate-Range

With the arrow buttons (3)

Attention
For safety reasons you cannot choose positions over 90,1 
oder -92,6 on the Y-axis with the arrow buttons (3).
For adjustments in excess of these coordinates you must 
use the pedal.

X -150 to X 230
Y 90,1 to Y -92,6

With the pedal

Each pedal step moves the cursor by 0,1 in the direction of 
the chosen axis (X or Y)

X -150 to X 230
Y 100 to Y -100

Insert the coordinates directly by the cursor postion (1) X -150 to X 230
Y 100 to Y -100
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Defining the seam parameters for the path

Fig. 94: Defining the seam parameters for the path

5. Tap the respective parameter.

 The window for entering the parameter value opens.

6. Enter the desired value for the parameter ( p. 102).

Seam parameters for teach-in

Button Meaning

Speed

Stitch length

Thread tension

Stroke height

Cut thread
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Drawing a path

7. Use the arrow buttons to move the cursor to the end point of the desired 
path.

Information

Alternatively, you can tap an arrow button once in order to define the 
direction and then continue moving in this direction by pressing the pedal.

Important

Take care to ensure that the contour remains within the permissible 
sewing field of your particular machine. Especially with curved paths, you 
should remember that the start and end points are not directly connected 
and that a curve is generated between these two points.

8. Tap the OK button.

 The seam path is adopted with the specified parameters.

Adding further seam paths

You can now define all further seam paths in the same manner. 

1. Add each new seam path by starting at step 4.

Deleting a seam path

1. Tap the Löschen (Delete) button.

 The last section of the seam path is deleted. 

Saving the program

After you have defined all the seam paths you can save the program and 
specify a name for the program.

1. Tap the Speich... (Save) button.

 The window for entering the program name opens.

2. Enter the desired name ( p. 101) and adopt the name by pressing 
OK.

 The program is now available under this name for sewing, editing or 
copying.

Important

Always perform a contour test after creating a new program ( p. 113). 
Ensure that the contour lies within the sewing field limits of your particular 
unit.
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6.11 Performing a contour test

Always perform a contour test every time after creating or editing a pro-
gram to ensure that the entire contour lies within the permissible sewing 
field.

To perform a contour test:

1. Tap the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Konturtest (Contour test).

 The Konturtest (Contour test) window appears.

Fig. 95: Performing a contour test

2. Move along the contour stitch by stitch using the Vor (Forwards) and 
Zurück (Back) buttons.

3. Check that all points lie within the sewing field.

NOTICE

Property damage may occur!

If you have entered contour points that lie outside the sewing field, 
the movement of the clamps during sewing can cause damage to the 
machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.
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6.12 Creating a new sequence

You can combine up to 30 seam programs to form a sequence. You can 
create up to 20 sequences.

1. Tap the menu items Datei (File) > Neu (New) > Sequenz 
(Sequence).

 The window for selecting the seam program appears.

Fig. 96: Creating a new sequence

The existing seam programs are displayed at the right side of the screen. 
The Sequenz (Sequence) field on the left shows the seam 
programs that have been transferred to the sequence.

2. Tap the desired seam program.

 The selected program is highlighted with a dark background.

3. Tap the Einfügen (Insert) button.

 The seam program is transferred to the sequence and is displayed in 
the Sequenz (Sequence) field on the left side of the screen.

4. Add further seam programs in the same manner.

Removing a program from a sequence

1. Tap the seam program in the Sequenz (Sequence) field and 
then tap the Löschen (Delete) button.

 The program is removed from the sequence.

Assigning a name to the sequence

1. Tap the Namen eingeben (Enter Name) button.

 The window for entering the sequence name opens.

2. Enter the desired name and adopt the change by pressing OK 
(( p. 101)).

 The sequence is now available under this name for sewing, editing or 
copying.
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6.13 Editing an existing sequence

You can edit an existing sequence by adding or removing seam programs.

To edit an existing sequence:

1. Open the program you wish to modify via the menu items Datei 
(File) > Öffnen (Open).

 The sequence opens on the start screen.

2. Tap the menu items Bearbeiten (Edit) > Sequenz 
(Sequence).

 The window for editing the sequence appears.

Fig. 97: Editing an existing sequence

3. Use the buttons Einfügen (Insert) and Löschen (Delete) to add 
programs to the sequence or remove programs from the sequence. 
The steps correspond to the procedure used for creating a new 
sequence ( p. 114). 
115 Service Instructions 911-211 - 02.0 - 10/2016



Programming
6.14 Saving a seam program/sequence under a different name

You can save a seam program or sequence under a different name.

Information

For example, if you wish to create a new program that is similar to an ex-
isting program you do not need to create the entire program anew. You 
can save the existing program under a new name and simply change the 
respective details.

To save a seam program or sewing sequence under a different name:

1. Tap the menu items Datei (File) > Speichern unter 
(Save As).

 A selection window allowing you to select a seam program or 
sequence appears.

Information

You can use the Dateifilter (File Filter) to make the list 
more manageable ( chap. 5.4.6 Using file filters, p. 38).

2. Tap the desired element.

3. Tap the Speichern unter (Save As) button.

 The window for entering the new name is opened.

4. Enter the desired name and adopt the change by pressing OK 
(( p. 101)).

 The program or sequence is now also available under this name for 
sewing, editing or copying.
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6.15 Copying a seam program or sequence

You can also copy seam programs or sequences from a USB key to the 
control or from the control to a USB key.

Important

Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler using the part 
number 9805 791113.

To copy a seam program or sequence:

1. Tap the menu items Datei (File) > Kopieren (Copy).

 The window for selecting the file to be copied appears:

Fig. 98: Copying a seam program or sequence

2. Use the buttons (1) to select whether the data is to be copied from the 
DAC control or the USB key.

 The selected button is highlighted with a dark background.
A selection window (2) lists all files present at this location.

Information

You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 100).

3. Tap the desired file.

 The selected file is highlighted with a dark background.

4. Tap the Datei kopieren (Copy File) button.

 The selected file is copied to the USB key or the control.

(1) - Select the source to be copied (2) - File selection window

① ②
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6.16 Deleting a seam program or sequence

Seam programs or sequences that are no longer required can be deleted 
from the control.

To delete a seam program or sequence:

1. Tap the menu items Datei (File) > Löschen (Delete).

 The window for selecting the file to be deleted appears:

Fig. 99: Deleting a seam program or sequence

Information

You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 100).

2. Tap the desired file.

 The selected file is highlighted with a dark background.

3. Tap the Löschen (Delete) button.

 The selected file is deleted.

6.17 Editing an existing seam program

You can change the contour and parameters of existing seam programs. 
The changes are applied to the seam program that is currently open on 
the start screen.

To edit an existing seam program:

1. Open the program you wish to modify via the menu items Datei 
(File) > Öffnen (Open) .

 The program opens on the start screen.
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6.17.1 Changing the contour of a seam program

To edit an existing seam program:

1. Tap the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Konturanpassing (Adjust 
Contour).

 The contour adjustment window appears:

Fig. 100: Changing the contour of a seam program (1)

2. Use the arrow buttons to move the cursor (1) to the position on the 
contour that is to be changed.

Information

You can also use the slider control on the scale (2) to select the stitching 
area you wish to change:
The first stitch of the seam is at the top and the last stitch is at the bottom.

3. Tap the Go To button.

 The selected contour region is displayed in detail.
The stitching point (2) to be modified is marked in red.

NOTICE

Property damage may occur!

If you have entered contour points that lie outside the sewing field, 
the movement of the clamps during sewing can cause damage to the 
machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.

(1) - Cursor (2) - Scale: First to last stitch

① ②
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Fig. 101: Changing the contour of a seam program (2)

4. Use the arrow buttons to move the stitching point to the new position (4).

 The modified seam path is displayed in green.

5. Tap the Weiter (Next) button.

 The window for entering the technology operations opens.

Fig. 102: Changing the contour of a seam program (3)

6. Select the desired technology operation(s) for the new seam path 
( p. 99).

7. Confirm the selection with OK.

 You are returned to the detail window with the modified contour.

8. Tap the Weiter (Next) button again.

 A query dialog is displayed, asking if you wish to adopt the changes. 
Agreeing to this dialog will save the modified contour.

Important: Always perform a contour test after modifying a contour to 
ensure that the new seam path lies within the permissible sewing 
field ( p. 113).

(3) - Old stitching point (4) - New stitching point

④

③
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6.17.2 Changing the parameters of a seam program

You can also change the general settings that apply to the entire seam 
program.

To change the parameters of a seam program:

1. Tap the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Parameters.

 The window for selecting the program parameter group appears:

Fig. 103: Changing the parameters of a seam program

2. Tap the desired parameter group.

 The individual parameters of this group are displayed.

3. Tap the desired parameter.

 The window for modifying the parameter value opens.

4. Set the parameter to the desired value ( p. 102).

There are 8 program parameter groups:

Symbol Parameter group

PP1 - Configuration
General settings

PP2 - Insertion mode
Insertion mode and position

PP3 - Removal mode
Removal mode and position

PP4 - Soft start
Number of stitches and speed

PP5 - Needle thread monitor
Sensitivity value for the needle thread monitor

PP6 - Thread consumption
Values for determining thread consumption
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Overview of the individual program parameters

PP7 - Offset:
Contour is offset in a particular direction

PP8 - Scaling: 
The size of the contour is changed.

PP1 - Configuration

Symbol Meaning

Seam name
max. 20 characters

Minimum sewing foot stroke height
(min. = 1.0 .. max. = 10.0; Def. = 5.0 mm)
Sets this as the minimum value of the programmable sewing foot stroke 
height so that only this value needs to be adjusted when sewing thicker 
materials.

Adjusting the thread tension
(min. = 10… max. = 200; Def. = 100%)
The thread tension profile for the entire contour is adjusted accordingly. 
A value of 100% means that no adjustments are made.

Adjusting the run-empty speed
(min. = 10… max. = 200; Def. = 100%)
The forwarding speeds are adjusted accordingly.

Clamp ID code
Barcode (ID code) of max. 10 characters for performing a safety check 
before the start of sewing (the barcode reader additional equipment must 
be activated)

Marking lamps
Up to four marking lamps for easier alignment of the sewing material can be 
controlled (the additional equipment must be activated)

Needle reversing mode 
The following options can be set:
Not active: The needle remains at the Stop position.
After the entire contour: After completing all seams in the contour the 
needle is reversed to the value specified in the machine parameters.
After every seam (Def.): The needle is reversed after every seam.

Needle cooling
(On/Off)
Activates/deactivates the needle cooling.

Adjusting the speed
(min. = 10… max. = 200; Def. = 100%)
The sewing speed is adjusted by the specified percent value.

Symbol Parameter group
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PP2 - Insertion mode

Symbol Meaning

Insertion mode
The following options can be set:
Mode 1 (Def.)
Clamp is opened in the loading position. The clamp is closed when the 
pedal is pressed. Pressing the pedal again starts sewing of the seam.
Mode 2
Clamp is opened in the loading position. Pressing the pedal closes the left 
part of the two-piece clamp for angle mounting. Pressing the pedal again 
closes the right part. Pressing the pedal again starts sewing of the seam.
Mode 3
Clamp is opened in the loading position. Pressing the pedal closes the right 
part of the two-piece clamp for angle mounting. Pressing the pedal again 
closes the left part. Pressing the pedal again starts sewing of the seam.
Mode 4
Quick-start mode:
Clamp is opened in the loading position. The clamp is closed and sewing of 
the seam is started when the pedal is pressed. With the alternating clamp 
the seam is automatically started after insertion.
This mode is only active when quick-start is enabled in the machine param-
eters. The machine must be switched off and on in order to enable the 
quick-start mode.
Mode 5
Clamp is remains closed in the loading position. Pressing the pedal again 
starts sewing of the seam.

Loading position
(On/Off)
With the loading position activated the clamps move to the desired position 
for convenient insertion of the sewing material.

Loading position X
The value range varies depending on the subclass and sewing field size.

 Loading position Y
The value range varies depending on the subclass and sewing field size.
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PP3 - Removal mode

Symbol Meaning

Removal mode
The following options can be set:
Mode 1 (Def.)
Clamp is opened in the removal position.
Mode 2
Clamp remains closed in the removal position. The clamp is opened when 
the pedal is pressed. 
Mode 3
Clamp remains closed in the removal position. Pressing the pedal opens 
the left part of the two-piece clamp for angle mounting. Pressing the pedal 
again opens the right part.
Mode 4
Clamp remains closed in the removal position. Pressing the pedal opens 
the right part of the two-piece clamp for angle mounting. Pressing the pedal 
again opens the left part.
Mode 5
Clamp remains closed in the removal position.

Removal position
(On/Off)
With the removal position activated the clamps move to the desired position 
for convenient removal of the sewing material after the sewing procedure.

Removal position X
The value range varies depending on the subclass and sewing field size.

Removal position Y
The value range varies depending on the subclass and sewing field size.

PP4 - Soft start

Symbol Meaning

Number of soft start stitches
(min. = 0 .. max. = 10; Def. 5)

Soft start speed
 (min. = 100 .. max. 2000; Def. 300 rpm)

PP5 - Needle thread monitor

(min.=0..max.= 99: Def. 5)
Is only active if activated in the machine parameters.
(A higher value makes the needle thread monitor less sensitive. 
99 = Needle thread monitor switched off in this program only.)
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PP6 - Thread consumption

Symbol Meaning

 Sewing material thickness  (min. = 0.. max. 20.0; Def. 0)
 The thickness of the sewing material when pressed together.

Material consumption adjustment
 (min. = -10.0 .. max. 10.0; Def. 0)
 Correction of the calculated values.

PP7 - Offset

Symbol Meaning

X offset 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)

Y offset 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)

PP8 - Scaling.

Symbol Meaning

X scaling 
(min. = 80… max. = 120; Def. = 100 %)
100% corresponds to the original size.

Y scaling 
(min. = 80… max. = 120; Def. = 100 %)

X scaling origin 
(min. = -150.0… max. = 150.0; Def. = 0.0 mm)

Y scaling origin 
(min. = -150.0… max. = 150.0; Def. = 0.0 mm)
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6.18 Editing machine parameters

You use the machine parameters to define the basic machine settings that 
apply to all programs.

To edit the machine parameters:

1. Tap the menu items Bearbeiten (Edit) > 
Machinenparameter (Machine parameters).

 The window for selecting the machine parameter group appears.

Fig. 104: Editing machine parameters

2. Tap the desired parameter group.

 The individual parameters of this group are displayed.

3. Tap the desired parameter.

 The window for modifying the parameter value opens.

4. Set the parameter to the desired value ( p. 102).

There are 6 machine parameter groups:

Symbol Parameter group

MP1 - Configuration
General settings

MP2 - Limit values
Limit values for speeds and positions

MP3 - Needle thread monitor
Behavior after thread breakage

MP4 - Thread cutting
Speed, position and tension

MP5 - Thread clamping
Starting angle

MP6 - Counters
Settings for program and bobbin counters
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Overview of the individual machine parameters

MP1 - Configuration

Symbol Meaning

Needle cooling 
The following options can be set:
None: No type of needle cooling is active. 
Air cooling (Def.): The needle is cooled with air while sewing the seam.
Ice cooling: Optional equipment.

Foot mode 
The foot can be operated in the following modes:
Hopper: The foot only presses on the sewing material while the needle is in 
the sewing material. 
Presser: The foot presses continuously on the sewing material.

Sewing field size 
Take care to ensure a valid sewing field size for your subclass when making 
the selection. (See chapter Technical data ( p. 168)).
Normal sewing field (Def.): A sewing field of up to 200 x 300mm is available. 
Extra-large sewing field: A larger sewing field can be used in conjunction 
with the alternating clamps.

Optional equipment 
Reduced clamp pressure: 
Optional equipment limiting the amount of clamp pressure to allow for better 
alignment on insertion. 
Marking lamps: 
Optional equipment providing orientation lines on insertion for easier align-
ment. Up to 4 marking lamps can be switched on for each program. 
This setting only activates the option; the actual switching is defined in the 
program parameters (see Marking lamps ( p. 122)).
Barcode scanner: 
Optional equipment for performing a safety check before sewing. 
A barcode can be stored with each program. Agreement with the barcode 
on the clamp is checked. Sewing only proceeds when the barcodes agree. 
You enter the barcode ID in the program parameters (see Clamp ID code 
( p. 122)).
Neat seam beginning:
Not available
Remaining thread monitor:
Optional device that monitors the thread remaining on the bobbin. Will issue 
an alert before shortly before the thread is used up.
Thread burner:
Device for burning off the thread. Instead of cutting using a thread cutter.

Clamp type 
The following clamp types are available:
Single clamp: One-piece parallel clamp with angle mount
Single clamp with hanger (Def.): One-piece parallel clamp with hanger 
mount
Double clamp: Two-piece parallel clamp with angle mount
Alternating clamp: Removable clamp
Special clamp: Special clamp
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Clamp limits 
Standard limits (Def.)
No additional structures are taken into account. 
Special limits
Individual limits are taken into account. 

Pedal mode 
The following options are available:
Mode 1: The current position of the pedal is evaluated. 
Mode 2 (Def.): The pedal must be returned to the initial position after every 
actuation before a new actuation is recognized. 
Mode 3: The current position of the pedal is evaluated. 
The quick-start mode is also enabled (see Insertion mode ( p. 123)).
The machine must be switched off and on in order to enable the quick-start 
mode.
Push button: In push button mode one sensor is used only for controlling 
the clamp motion (up and down). The other sensor is used for starting the 
sewing process.

MP2 - Limit values

Symbol Meaning

Max. speed 
(min. = 500 .. max. 1400; Def. 900 rpm)
All sewing programs are limited to this maximum speed.

Max. run-empty speed 
(min. = 10 .. max. 100; Def. 100%)
Limits all clamp movements between the seams to this value.

Feed starting angle 
(min. = 30 .. max. 350; Def. 300 degrees)
The clamp motion during the stitch starts at this angle of needle motion.

Feed phase 
(min. = 30 .. max. 100; Def. 30%)
This parameter defines how the clamp is to be moved during the stitch. 
(A value of 100% means that the desired clamp motion is distributed over 
the entire stitch.)

Needle reversing position 
(min. = 0 .. max. 359; Def. 0 degrees, with thread burner 20 degrees)
The needle is reversed at this angle in order to increase the clearance to 
the clamp.

 Edit time paths
 This function is only for Dürkopp Adler Service personnel.

Symbol Meaning
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MP3 - Needle thread monitor

Symbol Meaning

Needle thread monitor mode
The following options are available:
Threading position: After detection of a thread breakage the thread is cut 
and the clamp then moves to the threading position. 
Cut thread (Def.): After detection of a thread breakage the thread is cut and 
the clamp then moves to the contour position according to the defined 
reversing path.
Remain in position: After detection of a thread breakage, seam motion is 
stopped.
Not active: The needle thread monitor is ignored.

Reversing path after thread breakage 
(min. = 0 .. max. 20; Def. 5 stitches)
Number of stitches to be taken into account when reversing after a thread 
breakage.

Bobbin change X position 
The value range varies depending on the subclass and sewing field size.

Bobbin change Y position 
The value range varies depending on the subclass and sewing field size.

MP4 - Thread cutting

Symbol Meaning

Cutting speed 
(min. = 70 .. max. 500; Def. 150 rpm)
Speed of the cutting stitch.

Cutting position on 
(min. = 0° .. max. 359°; Def. 180°)
Angular position of the needle at which the thread cutting knife is switched 
on.

Cutting position off
(min. = 0° .. max. 359°; Def. 359°)
Angular position of the needle at which the thread cutting knife is switched 
off.

Thread tension during thread cutting 
(min. = 00 .. max. 100; Def. 10%, 50% with thread burner)
Thread tension of the cutting stitch.

Position for thread tension during thread cutting 
(min. = 0° .. max. 400°; Def. 370°)
Starting angle for the thread tension during the cutting stitch.
(At an angle greater than 359° the thread tension is activated in the next 
stitch.)
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MP5 - Thread clamping (for TC machines only)

Symbol Meaning

Close thread clamp at 1st stitch 
(min. = 0° .. max. 250°; Def. 180°)
Starting angle for closing the thread clamp during the first stitch.

Open thread clamp at 1st stitch 
(min. = 0° .. max. 359°; Def. 340°)
Starting angle for opening the thread clamp during the first stitch.
If the closing and opening angles are the same then the thread clamp is not 
activated.

MP6 - Counters

Symbol Meaning

Counter type 
The following options are available:
Piece counter increments (Def.)
The counter is incremented after each sewn program.
Piece counter decrements 
The counter is decremented after each sewn program.
Sequence counter increments 
The counter is incremented after each sewn sequence.
Sequence counter decrements 
The counter is decremented after each sewn sequence.

Reset value for the counters
(min. = 0 .. max. 9999; Def. 0)
Value to which the counter is set when a counter reset is performed.

Seam counting for bobbin supply
(min. = 0 .. max. 100; Def. 0)
A message is displayed to the user after the number of seams specified 
here have been sewn. A value of 0 deactivates the function.

Bobbin supply capacity
(min. = 0.0 .. max. 400.0; Def. 0.0m)
A message is displayed to the user after the bobbin supply capacity has 
been consumed. A value of 0 deactivates the function.
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6.19 Checking and changing the technical settings

The technical settings are made via the menu item Extras > Service.

Fig. 105: Checking and changing the technical settings

Important

A password must always be entered in order to access the additional 
menu items in Extras > Service ( p. 97).

Changing the password options

The default password on delivery is: 25483.

You can change this password and also define whether the password only 
applies to the technical menu items or must always be entered after the 
machine is switched on.

Changing the password

To change the password:

1. Tap the menu items Extras > Service > Einstellungen 
(Settings).

 The Einstellungen (Settings) window appears.

2. Tap the Operator Passwort (Password) option.

3. In the following window tap the option Passwort ändern 
(Change password).

 The window for entering the new password appears.

4. Enter the new password( p. 97).

Important

The password must not have more than 5 digits.

5. Confirm the new password with OK.
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Defining the password protected areas

To define the password protected areas:

1. Tap the menu items Extras > Service > Einstellungen 
(Settings).

 The Einstellungen (Settings) window appears.

2. Tap the Operator Passwort (Password) there.

 In the next window the Aktivieren/De-aktivieren 
(Activate/Deactivate) option indicates the type of pass-
word protection:

•   - Comprehensive password protection activated: 
Password protection of the first action after switching on

•   - Comprehensive password protection deactivated:
Password protection for the technical menu items only 

3. Tap the Aktivieren/De-aktivieren (Activate/
Deactivate) option to switch between each respective setting.

4. Confirm with OK.

Important

Switch the machine off and on again to adopt the setting.

Changing the language

To change the language:

1. In the menu item Extras > Service > Einstellungen 
(Settings) tap the Sprache (Language) option.

 The list of available languages is displayed.

2. Tap the desired language.

3. Confirm with OK.

 The screen is reloaded in the selected language.

Setting the date and time

To set date and time:

1. In the menu item Extras > Service > Einstellungen 
(Settings) tap the option Datum (Date) and Uhrzeit 
(Time).

 The data entry window for date and time is displayed.

2. Enter the date and/or time.

3. Confirm with OK.

 The entered values are adopted
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Setting the brightness

To set the brightness:

1. In the menu item Extras > Service > Einstellungen 
(Settings) tap the Bedienfeld-Einstellungen 
(Control panel settings) option.

2. In the following window tap the Kontrast (Contrast) 
Helligkeit (Brightness) option.

 A window with slider controls is displayed.

3. Pull the corresponding slider control up or down to change the value.

 The changes are immediately visible on the display.

Testing the touchscreen

You can use the Extras > Service > Einstellungen 
(Settings) menu item to check that the touchscreen is functioning 
correctly over all areas of the screen.

To test the touchscreen:

1. In the menu item Extras > Service > Einstellungen 
(Settings) tap the Bedienfeld-Einstellungen 
(Control panel settings) option.

2. In the following window tap the Touch Test option.

 An empty window is opened.

3. Use your finger to tap various different points or draw lines.

 When the touchscreen is functioning correctly all touched points of 
the screen are marked.

Testing the functions of the machine

You can use the Extras > Service > Multitest menu item to 
check the inputs and outputs, test the sewing motor and set the stroke 
position.

Fig. 106: Testing the functions of the machine
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Information

The functions  Transportklammer (Feed clamp) and 

 Fadenbrenner (Thread burner) are only intended for 
use by Dürkopp Adler Service personnel.

Testing inputs and outputs

Important

The instructions only provide an overview of the test possibilities.

The tests may only be performed by qualified specialists that have 
received training from Dürkopp Adler.

To test inputs and outputs:

1. In the menu item Extras > Service > Multitest tap the 
Eingänge / Ausgänge testen (Test inputs / 
outputs) option.

 The IO-Test (IO Test) Seite (Page) window is 
displayed.

Fig. 107: Testing inputs and outputs

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Do not reach into the machine during function 
testing of inputs and outputs.

(1) - Area for input elements (2) - Area for output elements

① ②
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The input elements are listed and selected at the left side (1) and the out-
put elements at the right side (2).

2. Use Auswahl (Select) + or Auswahl (Select) - to 
select the desired element in the respective area.

 The number of the element is displayed on the ausgewählt: 
(selected:) button.

3. Tap the ausgewählt: (selected:) button.

4. Test the element using the Ein/Aus (On/Off) or umschalten 
(switchover) buttons, depending on the type of the input or output 
element.

Input elements

No. Meaning

S1 Lower right clamp

S2 Lower left clamp

S9 Needle thread monitor active

S10 Bobbin cover closed

S11 Machine head latch closed

S13 Pedal forwards

S14 Pedal backwards

S16 Pressure monitor

S17 Quick stop

S100 Sewing motor reference

S101 X-axis reference

S102 Y-axis reference

S103 Z-axis reference

Output elements

No. Meaning

Y1 Foot mode

Y2 Bobbin cover

Y3 Needle cooling on

Y4 Right clamp

Y5 Left clamp

Y9 Threading switch lamp on

Y10 Oil level indicator warning light on

Y11 Burner transformer on

Y12 Upper burner

Y13 Lower burner

Y14 Thread suction device

Y25 Marking lamp 1 (Z)

Y26 Marking lamp 2 (Z)

Y27 Marking lamp 3 (Z)

Y28 Marking lamp 4 (Z)
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Setting the stroke position

To set the stroke position:

1. In the menu item Extras > Service > Multitest tap the 
Hublage einstellen (Set stroke position) option.

 The following options are displayed:

2. Tap the desired symbol and execute the function.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Do not reach into the machine when setting the 
stroke position.
Switch off the power to the drives when you wish to 
test the freedom of motion of the sewing foot rod.

Setting the stroke position

Symbol Meaning

Perform a reference run
Check the movement

Switch between a hopper and presser foot
Switch over the mode of operation

Move to position
Set the sewing foot height

Switch off the power to the drives
Manually check the freedom of motion of the sewing foot rod
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Test sewing motor

To test the sewing motor:

1. In the menu item Extras > Service > Multitest tap the 
Nähmotor testen (Test sewing motor) option.

 The sewing motor test screen is displayed:

Fig. 108: Test sewing motor

Important

Remove the thread from the needle and the thread lever before starting 
the test.

2. Tap the  button.

 The window for entering the speed opens.

3. Enter the desired value (300 - 2000 rpm).

4. Tap the  button.

 The window for entering the cutting speed opens.

5. Enter the desired value (70 - 500 rpm).

6. Tap the  button.

 The sewing motor runs at the entered speed.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Do not reach into the machine during the function 
test of the sewing motor.
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7. Tap the  button.

 The sewing motor stops.

8. Tap the  button.

 The sewing motor runs at the entered speed.

9. Tap the  button.

 The sewing motor stops, and the thread cutter is actuated.

Calling up log displays and error lists

You can access the log settings and error lists via Extras > Service 
> System-Information (System Information).

To call up log displays and error lists:

1. Tap the menu items Extras > Service > 
System-Information (System Information).

 The selection screen for system information appears.

Fig. 109: Calling up log displays and error lists

2. Tap the desired symbol.

Symbol Meaning

Control events
List of the latest errors

Log settings
Only for Dürkopp Adler Service personnel

Log display
List of the last log settings

Control panel status
Status appears in the log display
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Initializing the control and performing updates

You can use Extras > Service > Initialisierung 
(Initialization) and Update to reset the control and control 
panel to the factory defaults and to update the control with a new software 
version.

To initialize the control and perform updates:

1. Tap the menu items Extras > Service > Initialisierung 
(Initialization) and Update.

 The screen for initialization and update appears.

Fig. 110: Initializing the control and performing updates

Initializing the control

Important

Initializing the control resets all values to the factory default settings. 
All changes are lost. 
Only execute this option if you really want to return to the factory settings.

Order

Save your seam programs and sequences to a USB key before perform-
ing initialization.

1. Tap the Initialisierung (Initialize)  Steuerung 
(Control) option.

 The control is completely reset to the factory default settings.
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Initializing the control panel

Important

Initializing the control panel resets all values to the factory default settings. 
All changes are lost. 
Only execute this option if you really want to return to the factory settings.

1. Tap the Initialisierung des Bedienfelds
(Initialize control panel) option.

 The control panel is completely reset to the factory default settings.

Updating the control

Information

The latest software version is available in the download area at www.du-
erkopp-adler.com.

You can easily transfer a new software version from a USB key to the 
control.

Important

Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler using the part 
number 9805 791113.

To perform an update of the control:

1. Switch off the machine.

2. Insert the USB key into the USB port (1) on the operating terminal.

Fig. 111: Updating the control

(1) - USB port

①
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3. Switch on the machine.

 The software update is performed automatically.

Information

If the automatic update does not function then you can use the menu items 
Extras > Service > Initialisierung (Initialize) 
and Update > Option Update der (the) Steuerung 
(control) to load a specific software version.

Contact the Dürkopp Adler Service Hotline for this.

Displaying software version information

The menu item ? displays information on the software currently installed 
on the machine.

To display information on the software version currently used:

1. Tap menu items ? > Tap on Info.

 The following information is displayed:

• Class

• Subclass

• Software version

• Date of creation of this software version
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7 Creating programs with DA-CAD 5000

You can use the DA CAD-5000 program to create seam programs on a 
PC. The DA-CAD 5000 program is available as additional equipment.

This section only provides an overview of the program steps. A detailed de-
scription is provided in the  Operating Instructions for the DA-CAD 5000 
program.

Selecting the class

The first step is to select the class.

Fig. 112: Selecting the class

Creating the seam contour

The next step is to draw the seam contour.

Fig. 113: Creating the seam contour
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Saving the seam contour

Fig. 114: Saving the seam contour

The final step is to save the finished seam program and copy it to a USB 
key.

Important

Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler using the part 
number 9805 791113.

To save a seam contour:

1. Select the menu items Datenübertragung (Data transfer) 
> USB-Memorystick (USB memory stick) > Speichern 
(Save) (PC->>USB).

Order

After successfully saving to the USB key the following steps must be per-
formed at the machine:

Transferring the program to the machine

NOTICE

Property damage may occur!

If you have entered contour points that lie outside the sewing field, 
the movement of the clamps during sewing can cause damage to the 
machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.
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To transfer a program to the machine:

1. Insert the USB key and copy the desired file to the DAC( p. 117).

2. Open the copied program ( p. 104).

3. Adjust the program parameters (especially the sewing foot 
height) ( p. 121).

4. Perform a contour test to check the clamp motion ( p. 113).

 Sewing with the program can begin after successful testing/adjustment.
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8 Maintenance

8.1 Cleaning

WARNING

Risk of injury from flying particles!

Flying particles can enter the eyes, causing injury.

Wear safety goggles. 
Hold the compressed air gun so that the particles 
do not fly close to people. 
Make sure no particles fly into the oil pan.

NOTICE

Property damage from soiling!

Lint and thread remnants can impair the operation of the machine.

Clean the machine as described.

NOTICE

Property damage from solvent-based cleaners!

Solvent-based cleaners will damage paintwork.

Use only solvent-free substances for cleaning.
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8.1.1 Cleaning the machine

Lint and thread remnants should be removed after every 8 operating hours 
using a compressed air gun or a brush. If very fluffy sewing material is be-
ing sewn the machine must be cleaned more frequently.

Fig. 115: Cleaning the machine

Areas particularly susceptible to soiling:

• Cutter on the winder for the hook thread (4)

• Area under the throat plate (3)

• Hook (2)

• Area around the needle (1)

To clean the machine:

1. Remove any dust and thread remnants using a compressed air gun or 
a brush.

(1) - Area around the needle
(2) - Hook

(3) - Area under the throat plate
(4) - Cutter on the bobbin winder

2

1

4

3
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8.1.2 Cleaning the motor fan mesh

The motor fan mesh must be cleaned once a month using a compressed 
air gun. When very fluffy material is used for sewing, the motor fan mesh 
must be cleaned more frequently.

Fig. 116: Cleaning the motor fan mesh

To clean the motor fan mesh.

1. Remove any sewing dust and thread remnants using a compressed 
air gun.

(1) - Motor fan mesh

①
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8.2 Lubricating

The machine is equipped with a central oil-wick lubrication system. The 
bearings are supplied from the oil reservoir.

For topping off the oil reservoir, use only lubricating oil DA 10 or oil of 
equivalent quality with the following specifications:

• Viscosity at 40 °C: 10 mm²/s

• Flash point: 150 °C

You can order the lubricating oil from our sales offices using the following 
part numbers:

CAUTION

Risk of injury from contact with oil!

Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil. 
If oil has come into contact with your skin, wash the 
affected areas thoroughly.

NOTICE

Property damage from incorrect oil!

Incorrect oil types can result in damage to the machine.

Only use oil that complies with the data in the instructions.

CAUTION

Risk of environmental damage from oil!

Oil is a pollutant and must not enter the sewage 
system or the soil.

Carefully collect up used oil. 
Dispose of used oil and oily machine parts in 
accordance with national regulations.

Container Part no.

250 ml 9047 000011

1 l 9047 000012

2 l 9047 000013

5 l 9047 000014
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8.2.1 Lubricating the machine head

Proper setting

The oil level is between the minimum level marking and the maximum lev-
el marking.

Fig. 117: Lubricating the machine head

To lubricate the machine head:

1. Check the oil level indicator every day.

If the oil level is below the minimum level marking (3): 
Pour oil through the refill opening (1) but no higher than the maximum lev-
el marking (2).

(1) - Refill opening
(2) - Maximum level marking

(3) - Minimum level marking

MAX

MIN

1

2

3
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8.2.2 Lubricating the hook

The approved oil quantity for hook lubrication is a factory specification. 

Proper setting

1. Hold a piece of blotting paper next to the hook (1) while sewing.

 After sewing a stretch of approx. 1 m, the blotting paper will have 
been sprayed with a thin and even film of oil.

Fig. 118: Lubricating the hook

To lubricate the hook:

1. Turn the screw (2):

• Turn counterclockwise: more oil is released

• Turn clockwise: less oil is released

Information

The released amount of oil does not change until the operating time has 
run a few minutes. Sew for several minutes before you check the setting 
again.

(1) - Hook (2) - Screw

①

②
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8.3 Servicing the pneumatic system

8.3.1 Setting the operating pressure

Proper setting

Refer to the Technical data ( p. 168) chapter for the permissible 
operating pressure. The operating pressure cannot deviate by more than 
± 0.5 bar.

Check the operating pressure on a daily basis.

Fig. 119: Setting the operating pressure

To set the operating pressure:

1. Pull the pressure controller (1) up.

2. Turn the pressure controller until the pressure gage (2) indicates the 
proper setting:

• Increase pressure = turn clockwise

• Reduce pressure = turn counterclockwise

3. Push the pressure controller (1) down.

NOTICE

Property damage from incorrect setting!

Incorrect operating pressure can result in damage to the machine.

Ensure that the machine is only used when the operating pressure 
is set correctly.

(1) - Pressure controller (2) - Pressure gage

①

②
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8.3.2 Draining the water condensation

Water condensation accumulates in the water separator (2) of the pressure 
controller.

Proper setting

Water condensation must not rise up to the level of the filter element (1).

Check the water level in the water separator (2) on a daily basis.

Fig. 120: Draining the water condensation

To drain water condensation:

1. Disconnect the machine from the compressed air supply. 

2. Place the collection tray under the drain screw (3).

3. Loosen the drain screw (3) completely.

4. Allow water to drain into the collection tray.

5. Tighten the drain screw (3).

6. Connect the machine to the compressed air supply.

NOTICE

Property damage from excess water!

Excess water can cause damage to the machine.

Drain water as required.

(1) - Filter element
(2) - Water separator

(3) - Drain screw

①

② ③
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8.3.3 Cleaning the filter element

Fig. 121: Cleaning the filter element

To clean the filter element:

1. Disconnect the machine from the compressed air supply.

2. Drain the water condensation ( p. 153).

3. Loosen the water separator (2).

4. Loosen the filter element (1).

5. Blow out the filter element (1) using a compressed air gun.

6. Wash out the filter tray using benzine.

7. Tighten the filter element (1).

8. Tighten the water separator (2).

9. Tighten the drain screw (3).

10. Connect the machine to the compressed air supply.

NOTICE

Damage to the paintwork from solvent-based cleaners!

Solvent-based cleaners damage the filter. 

Use only solvent-free substances for washing out the filter tray.

(1) - Filter element
(2) - Water separator

(3) - Drain screw

①

② ③
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8.4 Checking the toothed belt

The condition of the toothed belt must be checked once a month.

Important

A damaged toothed belt must be replaced immediately.

Proper setting

• The toothed belt exhibits no cracks or fragile areas.

• When pressed with a finger, the toothed belt must yield no more than 
10 mm.

8.5 Checking the thread suction device

Proper setting

The thread is sucked in properly. Check on a regular basis if the thread 
suction device sucks in the thread properly without the walls of the hose 
sticking together.

To check the thread suction device:

1. As soon as the thread is no longer sucked in properly, blow talcum 
powder into the hose through the opening of the thread suction device.

8.6 Parts list

A parts list can be ordered from Dürkopp Adler. Or visit our website for fur-
ther information at:

www.duerkopp-adler.com

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch off the machine before checking the 
condition of the toothed belt.
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9 Decommissioning

You need to perform a number of activities if the machine is to be shut 
down for a longer period of time or completely decommissioned.

To decommission the machine:

1. Switch off the machine.

2. Unplug the power plug.

3. If applicable, disconnect the machine from the compressed air supply.

4. Remove residual oil from the oil pan using a cloth.

5. Cover the control panel to protect it from soiling.

6. Cover the control to protect it from soiling.

7. Cover the entire machine if possible to protect it from contamination 
and damage.

WARNING

Risk of injury from a lack of care!

Serious injuries may occur.

ONLY clean the machine when it is switched off. 
Allow ONLY trained personnel to disconnect the 
machine.

CAUTION

Risk of injury from contact with oil!

Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil. 
If oil has come into contact with your skin, wash the 
affected areas thoroughly.
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10 Disposal

The machine must not be disposed of in the normal household waste.

The machine must be disposed of in a suitable and proper manner and in 
accordance with all applicable national regulations.

When disposing of the machine, be aware that it consists of a range of dif-
ferent materials (steel, plastic, electronic components, etc.). Follow the 
applicable national regulations when disposing of these materials.

CAUTION

Risk of environmental damage from improper
disposal!

Improper disposal of the machine can result in 
serious environmental damage.

ALWAYS comply with the legal regulations 
regarding disposal.
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Troubleshooting
11 Troubleshooting

11.1 Customer Service

Contact for repairs and issues with the machine:

Dürkopp Adler AG

Potsdamer Str. 190
33719 Bielefeld, Germany

Tel. +49 (0) 180 5 383 756
Fax +49 (0) 521 925 2594
Email: service@duerkopp-adler.com
Internet: www.duerkopp-adler.comError and information messages
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11.2 Messages of the software

Error 
code

Description Troubleshooting

Sewing motor

1051 Sewing motor timeout
• Cable to sewing motor reference

switch defective
• Reference switch defective
• Machine head does not move freely 

or has excessive toothed belt 
tension

• Replace the cable

• Replace the reference switch
• Check the ease of movement and 

toothed belt tension of the machine 
head

1052 Sewing motor excess current
• Sewing motor cable defective
• Sewing motor defective
• Control defective

• Replace the sewing motor cable
• Replace the sewing motor
• Replace the control

1053 Sewing motor line voltage too high Check the line voltage

1055 Sewing motor overload
• Sewing motor blocked/not moving 

freely
• Sewing motor defective
• Control defective

• Fix blockage/sluggishness
• Check the sewing motor
• Check the control

1056 Sewing motor overtemperature
• Sewing motor not moving freely
• Sewing motor defective
• Control defective

• Eliminate seizing
• Replace the sewing motor
• Replace the control

1058
1302
1342

1344 

Sewing motor speed
• Sewing motor defective
Sewing motor error
Control not receiving pulses from 
pulse encoder in motor
Sewing motor error
Internal error 

• Replace the sewing motor
• Check the cable from the pulse 

encoder in the motor to the control
• Switch off and on the machine 

again
• Software update

Stepper motors

2101 X-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Faulty cable to the reference switch
• Reference switch defective

• Adjust reference switch
• Replace the cable
• Check the reference switch

2102 X-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable

• Replace the stepper motor

2152 X-axis stepper motor excess current • Replace the stepper motor
• Replace the control

2153 X-axis stepper motor overvoltage
• Too high line voltage • Check the line voltage

2155 X-axis stepper motor overload
• Feed system not moving freely
• Obstacle to feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion
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2156 X-axis stepper motor overtemperature
• Stepper motor sluggish
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace the stepper motor
• Replace the control

2201 Y-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Faulty cable to the reference switch
• Reference switch defective

• Adjust reference switch
• Replace the cable
• Replace the reference switch

2202 Y-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable

• Replace the encoder

2252 Y-axis stepper motor excess current • Replace the stepper motor
• Replace the control

2253 Y-axis stepper motor overvoltage
• Too high line voltage • Check the line voltage

2255 Y-axis stepper motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

2256 Y-axis stepper motor overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace the stepper motor
• Replace the control

2301 Stroke position stepper motor 
referencing timeout
• Faulty reference switch setting
• Faulty cable to the reference switch
• Reference switch defective 

• Adjust reference switch
• Replace the cable
• Replace the reference switch

2302 Stroke position stepper motor current 
error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable

• Replace the encoder

2352 Stroke position stepper motor excess 
current

• Replace the stepper motor
• Replace the control

2353 Stroke position stepper motor 
overvoltage
• Too high line voltage • Check the line voltage

2355 Stroke position step motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

Error 
code

Description Troubleshooting
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2356 Stroke position stepper motor 
overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate sluggishness
• Replace the stepper motor
• Replace the control

Machine control

3100 Machine control voltage 
• Temporary line voltage interruption • Check the line voltage

3102 Machine voltage in sewing motor 
intermediate circuit 
• Temporary line voltage interruption • Check the line voltage

3103 Machine voltage in stepper motor 
intermediate circuit 
• Temporary line voltage interruption • Check the line voltage

3107 Machine temperature 
• Ventilation openings closed
• Ventilation grille dirty

• Clean ventilation grille
• Check ventilation openings

3109 Threading mode is switched on Switch off threading mode

3121 Compressed air is missing or 
insufficient

Turn on the compressed air, stabilize

3123 Oil sensor active Top off oil

3210 Thread broken Re-thread the thread

3215 Bobbin empty (remaining thread 
counter)

Insert full bobbin

3220 Bobbin empty (remaining thread 
counter)

Insert full bobbin

3500 Error in calculating the contour data • Reload the contour data
• Check the contour data

3501 Target position of the XY clamps 
outside the motion limits 

Adjust the contour data

3502 Target position of the XY clamps 
within the "forbidden areas"

Adjust the contour data

3721
3722 

Internal error • Switch off and on the machine
• Software update
• Notify DA Service

4201 Internal CF card defective • Switch off and on the machine
• Retrofit/replace control

5301 Program cannot be sewn Copy program to DAC

Error 
code

Description Troubleshooting
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6551

6554
6651

6653
6751

6761

Error in machine head position/AD 
converter/process error

Internal error

• Switch off and on the machine
• Software update

• Notify DA Service

6952 Stepper motor driver error
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

Communication

7801 Control panel interface communication
• Cable disturbance
• Cable 

• Switch off and on the machine
• Software update
• Notify DA Service

8151
8156

8159

IDMA error
• Disturbance
• Control defective

• Switch off and on the machine
• Replace the control

 8152

8154

IDMA error
• Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

8252
8257
8258

8256
8254

ADSP Boot/Xilinx Boot/ Boot error
Disturbance

• Switch off and on the machine

8351 Test pins error • Switch off and on the machine
• Software update
• Notify DA Service

9601 Stop while sewing on the contour
Continue sewing?

• OK button = 
Continue the sewing process

• ESC button = 
Interrupt the sewing process

9700 Bobbin case retainer not closed Close the bobbin case retainer

9701 Parallel clamps not lowered • Remove obstacles
• Adjust sensors

9900 Incorrect machine parameters Initialize the data

9901 Incorrect sequences Initialize the data

9902 Incorrect program parameters Initialize the data

Error 
code

Description Troubleshooting
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11.3 Information messages

Information 
code

Description Troubleshooting

8400 Control panel has no valid 
program for the DAC.

Load the current program into the 
control panel from a USB key.

8401
8402

Control panel has no valid 
program for the DAC.

Load the current program into the 
control panel from a USB key.

8403 Program in DAC is no longer 
current.

Load the current program into the 
DAC.

8404

8407

DAC update failed. • Attempt the update again
• Check cable connections
• Replace the DAC

8408 Waiting for a DAC reset. Wait until the restart has been 
performed 
(Duration: several seconds).

8411 DAC program check is active. Wait until the test has been 
performed (Duration: several 
seconds).

8414 DAC update succeeded.

8801

8805
8806
8890
8891

Error in test pins/signal 
processing/event processing/
Memory wrapper/
list functions
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

System

9000 Reference run active

9002 Machine head not locked Lock the machine head

9006 Quick-stop button is active. Release the Quick-stop button

9016 Incorrect barcode ID Change the program

9100 The counter has not reached the 
specified value.

Tap the OK button. The counter is 
reset.
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11.4 Errors in sewing process

Error Possible causes Remedial action

Unthreading at seam 
beginning

Needle thread tension is too 
firm

Check needle thread tension

Thread breaking Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is bent or sharp-
edged

Replace the needle

Needle is not inserted 
correctly into the needle bar

Insert the needle correctly into 
the needle bar

The thread used is unsuitable Use recommended thread

Thread tensions are too tight 
for the thread used

Check thread tensions

Thread-guiding parts, such 
as thread tube, thread guide 
or thread take-up disk, are 
sharp-edged

Check threading path

Throat plate, hook or spread 
have been damaged by the 
needle

Have parts reworked by 
qualified specialists

Missing stitches Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is blunt or bent Replace the needle

Needle is not inserted 
correctly into the needle bar

Insert the needle correctly into 
the needle bar

The needle thickness used is 
unsuitable

Use recommended needle 
thickness

The reel stand is installed 
incorrectly

Check the assembly of the reel 
stand

Thread tensions are too tight Check thread tensions

Throat plate, hook or spread 
have been damaged by the 
needle

Have parts reworked by 
qualified specialists
Service Instructions 911-211 - 02.0 - 10/2016 166



Troubleshooting
Loose stitches Thread tensions are not 
adjusted to the sewing 
material, the sewing material 
thickness or the thread used

Check thread tensions

Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle breakage Needle thickness is 
unsuitable for the sewing 
material or the thread

Use recommended needle 
thickness

Error Possible causes Remedial action
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12 Technical data

Data and characteristic values

Characteristic 911-211-2010 911-211-3020

Machine type CNC sewing unit

Stitch type 301

Hook type Vertical hook

Needle system 794 on request 7x23 
(328 is possible with upgrade)

Needle strength [Nm] 140 - 230

Number of needles 1

Thread strength [Nm] 
(depending on material thickness and 
composition)
- Min.
- Max.

20/3
8/3

Stitch length (programmable) [mm] Maximum 12.7mm
(dependent on seam pattern)

Maximum speed [min-1] 
(intermittent and dependent on the stitch 
length and sewing material thickness)

1400

Clamp stroke [mm] 30 (24 with material thickness 
monitoring)

Foot lifter [mm] 20

Sewing foot stroke [mm] 
(can also be switched on and off 
pneumatically during the seam)

4 

Sewing field size [mm] 200 x 100 300 x 200

Number of free seam contours 99

Operating pressure [bar] 6

Air consumption [NL] 2

Table height
- Min.
- Max.

760 or 800 (with 0911 407524)
900 or 1050 (with 0911 407524)

Length/width [mm] 940/1100 1200/1200

Weight (fitted) [kg] 230

Line voltage [V] 230

Mains frequency [Hz] 50/60

Power [W] 450
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13.1 Wiring diagram 
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Appendix 
13.2 Wiring diagram - remaining thread monitor
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13.3 Pneumatic diagram
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